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Notice

All information included in this document is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sal es office. Also, please pay regular and careful attention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

Y ou should not ater, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. Y ou are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. 'Y ou should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the development of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errors in or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific’. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as
indicated below. You must check the quality grade of each Renesas Electronics product before using it in a particular
application. You may not use any Renesas Electronics product for any application categorized as “ Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not be in any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as“ Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is“ Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home el ectronic appliances, machine tools; persona electronic equipment; and industria robots.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.

“Specific™: Aircraft; agrospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or heathcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.

Y ou should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especialy with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with
applicable laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics’ as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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Notes regarding these materials

This document is provided for reference purposes only so that Renesas customers may select the appropriate
Renesas products for their use. Renesas neither makes warranties or representations with respect to the
accuracy or completeness of the information contained in this document nor grants any license to any
intellectual property rights or any other rights of Renesas or any third party with respect to the information in
this document.
Renesas shall have no liability for damages or infringement of any intellectual property or other rights arising
out of the use of any information in this document, including, but not limited to, product data, diagrams, charts,
programs, algorithms, and application circuit examples.
You should not use the products or the technology described in this document for the purpose of military
applications such as the development of weapons of mass destruction or for the purpose of any other military
use. When exporting the products or technology described herein, you should follow the applicable export
control laws and regulations, and procedures required by such laws and regulations.
All information included in this document such as product data, diagrams, charts, programs, algorithms, and
application circuit examples, is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas products listed in this
document, please confirm the latest product information with a Renesas sales office. Also, please pay regular
and careful attention to additional and different information to be disclosed by Renesas such as that disclosed
through our website. (http://www.renesas.com )
Renesas has used reasonable care in compiling the information included in this document, but Renesas
assumes no liability whatsoever for any damages incurred as a result of errors or omissions in the information
included in this document.
When using or otherwise relying on the information in this document, you should evaluate the information in
light of the total system before deciding about the applicability of such information to the intended application.
Renesas makes no representations, warranties or guaranties regarding the suitability of its products for any
particular application and specifically disclaims any liability arising out of the application and use of the
information in this document or Renesas products.
With the exception of products specified by Renesas as suitable for automobile applications, Renesas
products are not designed, manufactured or tested for applications or otherwise in systems the failure or
malfunction of which may cause a direct threat to human life or create a risk of human injury or which require
especially high quality and reliability such as safety systems, or equipment or systems for transportation and
traffic, healthcare, combustion control, aerospace and aeronautics, nuclear power, or undersea communication
transmission. If you are considering the use of our products for such purposes, please contact a Renesas
sales office beforehand. Renesas shall have no liability for damages arising out of the uses set forth above.
Notwithstanding the preceding paragraph, you should not use Renesas products for the purposes listed below:

(1) artificial life support devices or systems

(2) surgical implantations

(3) healthcare intervention (e.g., excision, administration of medication, etc.)

(4) any other purposes that pose a direct threat to human life
Renesas shall have no liability for damages arising out of the uses set forth in the above and purchasers who
elect to use Renesas products in any of the foregoing applications shall indemnify and hold harmless Renesas
Technology Corp., its affiliated companies and their officers, directors, and employees against any and all
damages arising out of such applications.
You should use the products described herein within the range specified by Renesas, especially with respect
to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas shall have no liability for malfunctions or
damages arising out of the use of Renesas products beyond such specified ranges.
Although Renesas endeavors to improve the quality and reliability of its products, IC products have specific
characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Please be sure to implement safety measures to guard against the possibility of physical injury, and
injury or damage caused by fire in the event of the failure of a Renesas product, such as safety design for
hardware and software including but not limited to redundancy, fire control and malfunction prevention,
appropriate treatment for aging degradation or any other applicable measures. Among others, since the
evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or
system manufactured by you.
In case Renesas products listed in this document are detached from the products to which the Renesas
products are attached or affixed, the risk of accident such as swallowing by infants and small children is very
high. You should implement safety measures so that Renesas products may not be easily detached from your
products. Renesas shall have no liability for damages arising out of such detachment.
This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written
approval from Renesas.
Please contact a Renesas sales office if you have any questions regarding the information contained in this
document, Renesas semiconductor products, or if you have any other inquiries.




Preface

The Renesas Tecnology SuperH RISC engine family of next-generation single-chip microcomputers offers high-
performance processing while incorporating a variety of peripheral devices, and are designed for embedded applications,
operating under low power consumption.

These application notes explain methods for the efficient creation of application programs which capitalize on the
functions and performance of the Renesas Tecnology SuperH RISC engine family using the SuperH RISC engine C/C++
Compiler Package V. 9.00.

For detailed specifications of the C/C++ compiler, please refer to the SuperH RISC engine C/C++ Compiler, Assembler,
Optimizing Linkage Editor User's Manual.

Organization of These Application Notes

These application notes consist of the following ten sections and an appendix.

Section 1 provides an overview and describes installation methods and the programming development procedure.
Section 2 illustrates the debugging process using various sample and explains program creation using the C language.

Section 3 gives warnings to be heeded when combining C language programs and assembly language programs, and when
using cross-software with object files created using the C/C++ compiler and explains extended functions of the SuperH
RISC engine C/C++ compiler, as well as procedures specific to software for embedded equipment.

Section 4 explains HEW options.

Section 5 and 6 explains methods for creating C language programs designed to capitalize on the performance of the
Renesas Tecnology SuperH RISC engine family of microcomputers.

Section 7 illustrates the utilizing method using HEW.

Section 8 illustrates efficient C++ programming technique.

Section 9 explains useful options, as well as functions that perform lateral optimization across modules during linking.
Section 10 presents answers to questions frequently asked by users.

The appendix describes changesin each version of the SuperH RISC engine C/C++ compiler.

Related Manuals

The following are related manuals.

e Renesas Tecnology SuperH RISC engine Family, Microcomputer Hardware Manuals

e SuperH RISC engine High-performance Embedded Workshop 3 User’s Manual

e SuperH RISC engine C/C++ Compiler, Assembler, Optimizing Linkage Editor User’s Manual
e SuperH RISC engine High-performance Embedded Workshop 3 Tutorial



Cross-Softwar e Versions

In order to use the SuperH RISC engine C/C++ compiler V. 9.00 the following cross-software versions should be used.

Cross Software Name Version
SH-series cross assembler 7.00
H-series optimizing linkage editor 9.00
SH-series library generator 3.00

Symbols and Conventions used in this Application Note
[T Indicates that the enclosed item can be omitted.
(RET): Indicates the Return (Enter) key is to be pressed.
A: Indicates one or more spaces or tabs.
abc: Boldfaced items are to be input by the user.
<> Items enclosed in these brackets should be specified.
Indicates that the immediately preceding item is specified one or more times.
H": Integer constants preceded by H' are in hexadecimal.
ox: Integer constants preceded by Ox are in hexadecimal .

UNIX isaregistered trademark in the United States and other countries, licensed exclusively through X/Open Company
limited.

MS-DOS® is aregistered trademark of Microsoft Corporation in the United States and other countries.

Microsoft® WindowsNT® operating system, Microsoft®,Windows®98 and Windows 2000 operating system,
Microsoft® WindowsMe® operating system, Microsoft® WindowsX p® operating system are registered trademarks of
Microsoft Corporation in the United States and other countries.

IBM PC isaregistered trademark of International Business Machines Corporation.

It is recommended that these application notes be read in the following manner.



No. Circumstances Use of these Application Notes
1  Using the SuperH RISC engine (1) The procedure for starting the compiler is

C/C++ compiler for the first time described in section 1.4, Method of Execution. In

(1) You want to learn how to use the section 1.5, Procedure for Program Development,

compiler to create load modules, and operations using cross-software necessary to

how to USe Cross-software. complete a load module are explained.

(2) You want to create programs (2) There are programs in sections 2.2 and 2.3,

which run on SH-1. SH-2. SH-2E Introduction of Sample Program.

SH-2A, SH2A-FPU, SH2-DSP, SH-3, These are programs provided in order to explain

SH3-DSP, SH-4, SH-4A and SH4AL- the bare minimum of compiler functions necessary

DSP. for embedded equipment. Please refer to them in
creating simple programs, and using the simulator,
debugger and other tools to confirm their
operation. Other compiler functions are described
in section 3, Compiler. If you encounter problems
in creating load modules, please refer to section
3.15, Issues Related to Cross-Software.

2 A program for embedded equipment (1) Read sections 2.2 to 2.3, Introduction of Sample
is to be created. Program, and section 3, Compiler, to discover

(1) There is a program used with functions you can use, and consider Whe_ther t_he

other microcomputers which will be assembly language code cannot be rewritten in the

ported C language. For information on combining assembly
language programs with C programs, please refer to
section 3.15.1, Issues Related to Assembly
Language Programs.

(2) A new program will be created.  (2) First read sections 2.2 to 2.3, Introduction of
Sample Program, for a summary of program
creation. Next proceed to section 3, Compiler, and
learn about the extended functions of the SuperH
RISC engine C/C++ compiler. In creating a
program, refer to section 5, Efficient Programming
Techniques, to ensure that your programs are
successful from the very start.

3 Execution speed is to be improved, Refer to section 5, Efficient Programming

or program size reduced. Techniques to improve performance.

4  The program does not run as Examine the warning information following each

expected.

relevant item, as well as the items in section 11.
Q&A, to determine whether there is any relevant
information.
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Section 1 Overview

Section1l Overview

11 Summary

The SuperH RISC engine C/C++ compiler enables effective creation in the C language of programs which take advantage
of the functions and performance of the Renesas Technology SuperH RISC engine family of single-chip microcomputers
for embedded applications.

This document explains procedures for creating application programs using this C/C++ compiler.

12 Features
The features of the SuperH RISC engine C/C++ compiler are as follows.
(1) Full complement of functions

The following functions can be used to create efficient application programs for the Renesas Technology SuperH RISC
engine family.

e C language representation of interrupt functions and special instructions for the Renesas Technology SuperH RISC
engine family

e Generation of position-independent code (excluding SH-1)

e Fast floating-point operations

e Sdlection of compiler settingsto give priority to speed of execution or efficiency of memory use

(2) Powerful optimization features

The following types of optimization are performed in order to utilize the performance of the Renesas Technology SuperH
RISC engine family with its RISC (Reduced Instruction Set Computer) type instruction set.

e Automatic/optimized allocation of local variablesto registers
e Alleviation of processing intensity

e Pipeline optimization

e Constant convolution

e String sharing

e Deletion of common expression/loop invariant

e Deletion of unnecessary text

e Optimization of tail recursion

e Optimization between modules

Hence programming is possible without the need to explicitly take into account the architecture of the Renesas
Technology SuperH RISC engine family.

1.3 Method of I nstallation

131 PC Version

The operating environment for the SuperH RISC engine C/C++ compiler for Windows 98/Me/2000/XP/NT, and the
procedure for installing on Windows 98/Me/2000/XP/NT, are explained below.
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(1) Operating environment

e Host computer: IBM PC-compatible
(CPU capable of running Windows 98/Me/2000/XP/NT)
e OS: Windows 98/Me&/2000/XP/NT (Japanese or English)
e Memory size: Minimum 128 MB, 256 MB or more recommended
e Hard disk space: 120 MB or more free disk space required (for full installation)
e Display: SVGA or better
e 1/O device: CD-ROM drive
e Others: Mouse or other pointing devices

(2) Method of installation

To install the integrated devel opment environment on the PC, click the Setup button in the [Add/Remove Programs applet]
in [Control Panel], and then follow the onscreen instructions.

(3) Using the compiler from the DOS prompt

When using the compiler from the DOS command line under Windows, certain environment variables must be set.
Explanation of Environment Variables

(a) Environment variable SHC LIB

Indicates where the main files of the SuperH RISC engine C/C++ compiler are saved.

(b) Environment variable SHC_TMP

Specifies the path for creation of temporary files used by the C/C++ compiler. This setting cannot be omitted.

(c) Environment variable SHC INC

This environment variable is set when reading the standard header files for the C/C++ compiler from a specified path.
Several paths can be specified by separating them with commas (',). If this environment variableis not set, the standard
header fileisread from SHC LIB.

First, create abatch file with the contents shown below, which are necessary when starting with the DOS prompt. If such a
batch file already exists, the items shown below should be added. The example shown below is for installation of the
integrated environment to hard disk drive C.

To set the path, first use the SET command at the MS-DOS prompt to determine the current path setting, and then add to it
as necessary.

The following are examples of notation for batch files.

PATH C:\Hew3\Tools\Renesas\Sh\9_0_0\bin; $%PATHS%

SET SHC_LIB=C:\Hew3\Tools\Renesas\Sh\9_0_0\bin

SET SHC_TMP=C:\tmp

SET SHC_INC=C:\Hew3\Tools\Renesas\Sh\9_0_0\include
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Next, enter the path of the batch file below as the Batch file on the [Program)] tag of the DOS prompt properties dialog.

M5-D0O5 Prompt Properties |

| Font I Meml:uryl Screenl Misc I

RS b5-D05 Prampt

e |

Crnd line: IE: W NDOW S COMBAND COR
Working: n: W INDOWS

Batn::h file: In: Yhewhaetzho, bat

Shartzut key: INn:nne

Bun: INu:nrmaI window

¥ Cloze on egit

Advanced... | Ehangelcnn...l

Cancel | Apply |

o |

Figure 1.1 MS-DOS Prompt Properties (1)

On completing the above settings, restart the MS-DOS prompt session.

If, on running the batch file, the message "Insufficient space for environment variabl
following change.

Note:

es' appears, please make the

RENESAS
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M5-D0O5 Prompt Properties |

Generall F'rl:ugraml Font  Memory | Screenl bizc I

— Conventional memaory

Toatal: Im - I
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[ritial

Enyironment; I.ﬁ.utu:u - I

—Expanded [EbMS] memaory
Total: I.-'l'-.uh:u - I

— Extended [=M5] memany

Total: I.-'l'-.uh:u - I

¥ Uses Hia

—M5-005 pratected-made [DPRI] meman

Total; I.-'l'-.uh:u - I

k. I Cancel | e[ |

Figurel.2 M S-DOS Prompt Properties(2)

On the [Memory] tag of the DOS prompt properties dialog, change the "Initial environment” from Automatic to 1024.

After changing this setting, the MS-DOS prompt session must be restarted.

132 UNIX Version

The procedure for installing the C/C++ compiler on a UNIX system is described below.
Note: Do not use Japanese characters or spaces in the name for the installation directory.
(1) Instalation media

The compiler is distributed on asingle CD-ROM.

(2) Method of installation

Please use the following procedure to install the compiler. Wherever (RET) appears in the instructions, the Enter (Return)
key isto be pressed.

(@) Compiler/simulator installation
The procedure for compiler/simulator installation is as follows.
(i) Creating a path for the compiler/simulator

Create a path for storage of the compiler files, using any arbitrary name.

% mkdir A<compiler and simulator pathname> (RET)
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(if) Mounting the CD-ROM
Mount the CD-ROM as indicated below. If mounting is performed automatically, the following command is not required.

[For Solarig]

% mountAr AFAhsfsAdev/dsk/cOt6d0s2A/cdrom (RET)
[For HP-UX]

% mountA/dev/dsk/c201d2s0A/cdrom (RET)

(iii) Copying the compiler/simulator

Move to the newly created path, and then decompress the files for the SuperH RISC engine C/C++ compiler/simulator
from the CD-ROM to the path created in (i) above.

[For Solaris]

% cdA<compiler and simulator pathname> (RET)

% tar A-xvfA/cdrom/sh c sim pack sparc/Program.tar (RET)

[For HP-UX]

% cdA<compiler and simulator pathname> (RET)

% tar A-xvfA/cdrom/Program.tar (RET)
(iv) Changing environment settings
Set environment variables and pathnames as follows. (Double asterisks ** indicate an appropriate value should be

specified.) For details on environment variables, refer to the SuperH RISC engine C/C++ Compiler, Assembler,
Optimizing Linkage Editor User's Manual.

% setenvASHC_L IBA<compiler and simulator pathname> (RET)

% setenvASHC_INCA<compiler and simulator pathname> (RET)

% setenvASHC_TMPAusr/tmp (RET)

% setenvASHCCPUASH** (RET)

% setenvAHLNK _TMPA/usr/tmp (RET)

% setenvVAHLNK _LIBRARY 1A<compiler and simulator pathname>/****** |ib (RET)

% setenvVAHLNK _LIBRARY 2A<compiler and simulator pathname>/****** |ib (RET)
(v) Unmount the CD-ROM.

% umountA/cdrom (RET)

(b) Simulator installation
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The procedure for installing the UNIX simulator in versions earlier than Ver 8 is asfollows.
(i) Mounting the CD-ROM
Refer to the README.TXT file for the procedure to mount the CD-ROM.

When using the method described in the README.TXT file to copy cross-software, move to the directory to whichiit is
copied, and then proceed to the explanation in (iii), Start the installer.

(ii) Load the installer from the tar file on the CD-ROM.

(The following example assumes that the CD-ROM drive device nameis/cdrom.)

tar AxvfAcdrom/program.tarAcas install (RET)
(iii) Start the installer.

casinstall (RET)

(iv) Display immediately after installer startup
The following message is displayed immediately after the installer is started.
Installation of the cycle-accurate simulator starts. Input parameter s according to the messages.
(v) CPU selection
Select the simulator CPU to be used. (In this example, "10" selects the SH4 CPU.)
If the CPU SH4 or SH2DSP is selected, proceed to the explanation (vi) Co-verification tool selection.

If a CPU other than SH4 or SH2DSP is selected, proceed to the explanation (vii) Input name of directory for installation of
definition files.

Target
CPU(1:8H1,2:8H2,3:8H3,4:SH3E, 5:SHDSP, 6:SH2E, 7 : SH4BSC, 8: SH3DSP, 9: SHDSPC, 10:SH4, 11:SH2DSP)
: 10

(vi) Co-verification tool selection

If the CPU SH4 or SH2DSP was selected in (v), select the name of the simulator co-verification tool to be used. (In this
example, "1" selects “ Seamless’.)

When not using a co-verification tool, select “No”.

If the CPU SH2DSPis selected in (v), Eaglel cannot be selected.

SH-4:Please select Co-Velification Tool(l:Seamless,2:Eaglei,3:No): 1

(vii) Input name of directory for installation of definition files

Input the directory for installation of definition files. The directory enclosed in parentheses () is the default. The default is
generated according to the following rules.

<current directory> + "/df_CSDSH"
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If the default directory name is acceptable, simply enter (RET). A directory name can be entered either as an absolute path
or as arelative path. (In the example, (RET) isinput.)

Directory name for the definition files(/export/homel/cas/cassh3sim/df_CSDSH): (RET)

(viii) Enter the name of the host machine with the CD-ROM drive

Input the name of the host machine with the CD-ROM drive. The default is the name of the startup host. When installing
from a CD-ROM drive of the startup host, press (RET).

When installing from a CD-ROM drive of another host on a network, input that host's name. However, in thiscase, itis
assumed that login from aremote shell is possible (the /etc/hosts.equiv and SHOME/.rhosts files are set). For details on the
environment settings for remote shells and related matters, refer to the manual for the startup machine.

When installing from the startup host’s CD-ROM drive, proceed to the explanation (x) Input tar file name.

When installing from a CD-ROM drive of another host on the network, proceed to the explanation in (ix), Input the login
name of the host machine with the CD-ROM drive. (In the example below, the name of the host with the CD-ROM drive

issp3.)

Host name connected to a tape driver(sparc2): sp3 (RET)

(ix) Input the login name of the host machine with the CD-ROM drive

Input the login name of the host machine with the CD-ROM drive. This message is displayed when installing from a CD-
ROM drive of another host. (In this example, the login name for the host machine with the CD-ROM driveis "remote.")

Login name of host connected to a tape driver:remote (RET)

(X) Input tar file name

Input the tar file name. The default is/dev/rmt/Om for the HP9000, and /dev/rmt/0 for SPARC. (The following example
assumes that the CD-ROM drive device nameis/cdrom.)

Tape driver name(/dev/rmt/0): /cdrom/simulator.tar (RET)

(xi) Input (RET) before installation of definition files

Confirm that the CD-ROM with the definition files is mounted on the CD-ROM drive, and enter (RET).

Input return, after setting the tape including the definition files to the tape driver.
(RET)

(xii) Choose whether to install main files
Choose whether or not to install the main files for the interface software.
Toinstall the main filesenter "y," otherwise enter "n."

If "n" is entered, proceed to the explanation (xv) Choose whether to install setup files.
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(In thisexample, "y" is entered.)

Do you install the main files?(y/n):y (RET)

(xiii) Input of directory name for main files

Input the directory for installation of interface software main files.

The default is generated according to the following rule.

<current directory> + "/main"

A directory name can be entered either as an absolute path or as arelative path.

(In the following directory, (RET) isinput.)

Directory name for the main files(/export/homel/cas/cassh3sim/main): (RET)

(xiv) Input (RET) before main file installation

Confirm that the CD-ROM with the interface software main filesis mounted on the CD-ROM drive, and enter (RET).

Input return,after setting the tape including the main files to the tape driver. (RET)

(xv) Choose whether to install setup files
Choose whether or not to copy the setup samplefiles. To copy the setup files enter "y," otherwise enter "n."

(In thisexample, "y" is entered; then the installation file name is displayed.)

Do you copy the setup files to current directory?(y/n): y (RET)

(xvi) Choose path and environment variable settings
Choose whether or not to add path and environment variable settings to the shell script.

If "y" isentered, the installer determines the login shell type from the "SHELL" environment variable, backs up an
arbitrary shell script file (see table 1.1) beneath the directory specified by the "HOME" environment variable, and then
sets the path and environment variable information.

Settings conform to the following specifications.
If the main files have not been installed (see (xii) Choose whether to install main files), path settings are not changed.

If arelative path was specified in (vii) Input name of directory for installation of definition files or in (xiii) Input of
directory name for main files, the path and environment variable information is set using the input path information, and
execution is not possible in directories other than the directory in which the installer was started.

If "n" is entered, the installer proceeds to (xviii), Installation completed message, and the installer is terminated.

Table 1.1 Filenames Used for Different Shells

No. Shell Name Script File Name Backup File Name
Bourne shell (sh) .profile .profile.bak
2 C shell (csh) .cshrc .cshrc.bak
Korn shell (ksh) .profile .profile.bak
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(Inthis example, "y" is entered; thereafter the shell script is displayed.)

Do you append the path list and the environment variables in shell script?(y/n): y (RET)

/export/homel/cas/.cshrc

(xvii) Choose whether to overwrite the backup file

When backing up the shell script, this message is displayed if there exists afile with the same name as the backup file.
Choose whether or not to overwrite thefile,

(In this example, the login shell isthe C shell.)

Do you overwrite the backup file(.cshrc.bak)?(y/n): vy (RET)

(xviii) Installation completed message

When al steps of the installation are completed, the following message is displayed and the installer terminates.

Installation of the cycle-accurate simulator completed.

(c) Installation of the Acrobat® Reader

The manual can be viewed from within Windows. The software used to view the manual (the Acrobat® Reader) should be
installed on a computer running Windows 98/Me/2000/X P/NT.

Acrobat® Reader copyright ® 1987-2001 Adobe Systems Incorporated. All rights reserved.
Adobe and Acrobat are trademarks of Adobe Systems and are registered in specific jurisdictions.

The following procedure is used to execute installation. Before commencing the installation procedure, be sure to close all
applications:

(i) Insert the CD-ROM provided into the CD-ROM drive. (Hereit is assumed that the CD-ROM driveisdrive D.)

(if) From the Windows® Start menu, click on [Run ...].

(iii) Specify in the [Run ...] dialog box either Acrobreader51 jpn.exe (Japanese) in the [PDF_Read\Japanese] directory on
the CD-ROM or Acrobreader51_eng.exe (English) in the [PDF_Read\English] directory
(example:D:\PDF_Read\Japanese\ Acrobreader51 jpn.exe), and then click [OK].

(iv) Follow the onscreen installation instructions.
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14 Method of Execution

141 Starting the Embedded Workshop

Upon completion of installation, the installer for the Embedded Workshop creates a folder named " Embedded Workshop
2" within the Programs folder in the Windows Start menu, and within this folder places shortcuts to the executable

program for the Embedded Workshop and to other files.

The content of the start menu may vary depending on which tools are installed.

Callwialker
@ HB85.H8 300 Sirmulatar Debugger Help

|5§E] High-performance Embedded ‘Wworkshop 2 Help
@ High-performance Embedded workshop

53'3 High-performance Embedder

HIM To HEMW Project Converter

@ I apview

4 'E Online kanuals [H85.HE 300] -English(03 04]

2 Read Me

Favarites L e Tl T Online Manuals [SuperH] Englishil3 14)

@ D_ " b |'_§9 SuperH RISC engine Simulator Debugger Help
Diocuments

_% Seftings »

x) ’

Figurel.3 Startup of the Embedded Workshop from the Start Menu

Upon clicking on the Embedded Workshop item in the Start menu, a startup message is displayed, followed by a

Welcome! dialog box (figure 1.4).

— Optiomns:

2=

% {* Treate a new project workspace]
{~ Cpen a recent project workspace:
é IG:¥HEW2¥tutDria|¥tutu:uria|.hws LI

=  { Browse to another project workspace

(8] 4

Cancel

Adminiztration...

Figurel.4 Welcome! Dialog Box

When using the Embedded Workshop for the first time, or when beginning work on a new project, select [Create a New
Project] and click [OK]. In order to resume work on a project that has already been created, select [Open an Existing
Project] or [Browse to another project workspace] and click [OK]. No matter which of these is selected, clicking on [Exit]
causes the Embedded Workshop to terminate. By clicking on [Administration...], system tools used with the Embedded

Workshop can be registered and del eted.
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142 Starting the Compiler

In this subsection, the method for executing the SuperH RISC engine C/C++ compiler is explained, along with examples.
For details on compiler options, refer to the SuperH RISC Engine C/C++ Compiler, Assembler, Optimizing Linkage
Editor User's Manual. When using the PC version, refer to the Operating Manual.

Table 1.2 Table of compiling conditions

Command Option Extension of File(s) to be Compiling Conditions
Compiled
shcpp Any Any C++-compiled
shc -lang=c Any C-compiled
-lang=cpp C++-compiled
No lang option specified e C-compiled
*.cpp, *.cc, *.cp, *.CC C++-compiled

The command shc C-compiles* or C++-compiles C programs and C++ programs, respectively, according to the lang
option or the extension of the program file name. The command shcpp C++-compiles all programs, regardless of whether
they are C programs or C++ programs. Compiling conditions are described in table 1.2.

Note: *C-compiling means a program is compiled based on C language syntax; C++-compiling means a program is
compiled based on C++ language syntax.

Below the basic procedures for using the compiler are explained.
(1) Program compiling
To compile the "test.c" C source program:

shcAtest.c (RET)

To compile the "test.cpp" C++ source program:

shcAtest.cpp(RET)

shcppAtest.cpp(RET)

(2) Displaying command input formats and compiler options

This command displays alist of command input formats and compiler options on the standard output screen.

shc (RET)
shepp(RET)
(3) Specifying options

Options (debug, listfile, show, etc.) are prefixed with a hyphen (-), and multiple options are separated by spaces (A). In the
PC version, aslash (/) can be used in place of the hyphen at the DOS prompt.

When specifying multiple suboptions, they should be separated by commas (,).

shcA-debugA-listfileA-show=noobject,expansionAtest.c(RET)

In the PC version, parentheses can also be used to enclose suboptions.
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shcA/debugA/listfileA/show=(noobj ect,expansion)Atest.c(RET)
(4) Compiling multiple C/C++ programs

Multiple C/C++ programs can be compiled at once. The following are examples of commands for compiling C source
programs.

Example 1: Specifying multiple programs for compiling

shcAtest1.cAtest2.c (RET)

Example 2: Specifying options (options are specified for all C source programs)

shcA-listfileAtest1.cAtest2.c (RET)

The listfile option is effective for both test1.c and test2.c.

Example 3: Specifying options (options are specified separately for each program)

shcAtest1.cAtest2.cA-listfile(RET)

Here the listfile option is effective only for test2.c. Specification of options for individual programs takes priority over
specification of options for al source programs.

Notes:
(1) If, after installation, the compiler cannot be run, check the following.
e Confirm that the PATH environment variable includes the directory containing the C/C++ compiler.

e Confirm that the SHC_LIB environment variable is set to the directory containing the main C/C++ compiler
files.

The SHC _LIB environment variable is used to set the directory containing the main C/C++ compiler files.
Hence if the full set of C/C++ compiler filesis not placed in the same directory, the compiler will not run.

(2) The compiler determines the syntax to be used at compile time according to whether the shc or the shcpp
command is used; but even when the shc command is used, it will perform C++-compiling depending on file
extensions and options.
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15 Procedurefor Program Development

Figure 1.5 shows the procedure used to develop a C/C++ language program. The shaded area shows the software provided

as the SuperH RISC engine C/C++ compiler package.
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Figure 1.5 Procedurefor Program Development

Below the procedure for program development is explained for the example of a source file on_motor.c. For details of use

of cross-software, please refer to the user's manual for the cross-software package.
(1) Create asourcefile

Use the editor to create a source file.

RENESAS
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(2) Generate arelocatable object file

Start the compiler, and compile the sourcefile.

shcAon_motor.c (RET)

A relocatable object file called on_motor.obj, which is optimized and without debugging information, is generated. In
order to generate alist file, specify the listfile option.

(3) Generate aload modulefile

On including the library file sensor.lib and starting the linkage editor, an executable load modul e file with the name
on_motor.abs is generated.

optInkA-nooptA-subcommand = link.sub (RET)

The contents of Ink.sub are as follows.

Sdebug

input on_motor
library sensor.lib
Exit

Even if arelocatable object file contains debugging information, if the debug option is omitted when linking, no
debugging information is output to the load modulefile.

(4) Stypeformat file output

In order to writeto an EPROM using a ROM programmer, Ink.sub should be coded as follows.

Form=stype

Sdebug

input on_motor

library sensor.lib

Exit

An S-type format load module file with the name on_motor.mot is generated.

Rev.4.00 2007.02.02 1-14
REJO5B0463-0400
RENESAS



Section 2 Procedure for Creating and Debugging a Program

Section2  Procedure for Creating and Debugging a Program

2.1 Creating a Project

211 Creating the Project for a Simulator Debugger
(1) Specify the project

When you have selected the [ Create a new project workspace] radio button and clicked [OK] on the [Welcome!] dialog
box, the [New Project Workspace] dialog box (figure 2.1), which is used to create a new workspace and project, will be
launched. Y ou will specify aworkspace name (when a new workspace is created, the project name is the same asthe
default), a CPU family, a project type, and so on, on this dialog box.

Enter “tutorial”, for example, in the [Workspace Name] field, then the [Project Name] field will show “tutorial” and the
[Directory] field will show “c:\hew2\tutorial”. If you want to change the project name, enter anew project name manually
in the [Project Name] field. If you want to change the directory used for the new workspace, click the [Browse...] button
and specify adirectory, or enter adirectory path manually in the [Directory] field.

Here, specify [Demonstration] as a left-hand side Project type.

New Project Workspace 2lx
Projectz |

@ pplication wiorkspace Manme:

Demanstration IlUtUTia|

@ Ernphy ﬁl‘-.ppllc:‘latlu:un Project Name:

1@ Import b ak efile -

G Library Itutunal
Directon:
IE:'\Hew3\tutoriaI Browse. . |
CPLU family:
ISuperH RISC engine j
Toal chair:
IFlenesas SuperH Standard j

Properties... |

Canicel |

Figure2.1 New Project Workspace Dialog Box
(2) Selecting the Target CPU

When you click [OK] on the [New Project Workspace] dialog box, the project generator will be invoked. Start by selecting
the CPU that you will be using. CPU types shown in the [CPU Type] list are classified into the CPU series shown in the
[CPU Serieq] list.The selected itemsin the [CPU Series] list box and the [CPU Type!] list box specify thefilesto be
generated. Select the CPU type of the program to be developed. If the CPU type which you want to select is not displayed
in the [CPU Type] list, select a CPU type with similar hardware specifications or select [Other].
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e Clicking [Next>] movesto the next display.

o Clicking [<Back] moves to the previous display or the previous dialog box.

e Clicking [Finish] opensthe [Summary] dialog box.

o Clicking [Cancel] returns the display to the [New Project Workspace] dialog box.
[<Back], [Next>], [Finish], and [Cancel] are common buttons of all the wizard dialog boxes.

In thistutorial, select [SH-1] in the [CPU Series] list (figure 2.2). Then click [Next >].

If you have selected “ demonstration” , you cannot select CPU Type.

Mew Project-1/5-Select Target CPLU. Toolchain ¥ersion

Wwhich CPU do vou want to use for thiz
project’?

CPU Series:

SH-2 |
SH-ZE

SH-24
SH24-FPU |

CPU Type:

SHTO0Z0
SHT0
SHF032
SHT034
Other

[f there iz no CPU type to be selected,
gelect the "CPU Tope'' that a zimilar to
hardware specification or zelect "'Other'’.

< Back | et = I Firizh Cancel

Figure2.2 New Project Step 1 Dialog Box
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(3) Option Setting

Clicking the [Next>] button on the Step-1 screen opens the dialog box shown in figure 2.3. On this screen, you can specify
options common to all project files. Settings for these options can be modified in correspondence with the CPU series
selected in step 1 screen. To change the option settings after a project has been created, select the CPU tab from the
[Options -> SuperH RISC engine Standard Toolchain] menu item of the HEW window.

Click the [Next>] button without changing the setting. The Step-3 screen will be displayed.

Mew Project-2,/5-Option Setting 21 x|

Specify global options.

Endiar: Eig -
FEIE Mix of

Hotird: IZern ]'

Denormalized number allower az a result
[JPozition independent code [PIC)

[ITreat double az float

[JUse tro, throw and catch of C++
["JEnable/dizable runtime type infarmation
[C]Bit field's members are allocated from the low
[(JPack. struct, union and clazs

1] | H
< Back | Mt I Finizh | Cancel |

Figure2.3 New Project Step 2 Dialog Box
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(4) Setting the Target System for Debugging

When the [Next>] button is clicked in the Step-2 screen, the screen shown in figure 2.4 is displayed. This screen isused to
specify the target system for debugging. Select (check) the target for debugging from the list under [ Target:]. Selection of
no target or of multiple targetsis allowed.

In thistutorial, select [SH-1 Simulator] and then click the [Next>] button.

New Project-3,/5-Setting the Target System for Debugging _'?lil
— Targets
[C15H-1 Simulator
1] | H
Target type : ISH"l j
< Back | Ment » I Finizh | Cancel |

Figure2.4 New Project Step 3 Dialog Box
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(5) Setting the Debugger Options

When the [Next>] button is clicked in the Step-3 screen, the screen shown in figure 2.5 is displayed. This screen isused to
specify the optional settings for the selected target for debugging.

By default, the HEW creates two configurations, [Release] and [Debug]. When atarget for debugging is selected, the
HEW creates another configuration (The name of the target is included).

The name of the configuration can be modified in [Configuration name:]. Options to do with the target for debugging are
displayed under [Detail options:]. To change the settings, select [Item] and then click [Modify]. When items for which
maodification is not possible are selected, [Modify] remains grayed even if [Item] is selected.

In thistutoria, click the [Next>] button without changing the settings.

Mew Project-4/5-Setting the Debugger Options _'?lil

Target name :

|SH-1 Simulator

Canfiguration name ;
| SimD ebug_SH-1

— Detail options
[tem | Setting
Simulator 10 enable
Sirnulator 140 addr. - Ox0
Bus mode 0

Tiodify |

< Back | Ment » I Finizh | Cancel |

Figure2.5 New Project Step 4 Dialog Box

Rev.4.00 2007.02.02 2-5
REJO5B0463-0400
RENESAS



Section 2 Procedure for Creating and Debugging a Program

(6) Confirming Settings (Summary Dialog Box)

Clicking on [Next >] on the Step-4 screen displays the screen shown in figure 2.6. On this screen, display the sourcefile
information for the project to be created. After confirmation, click [Finish].

Clicking [Finish] on the Step-5 screen, the project generator shows alist of generated files on the [Summary] dialog box
(figure 2.7). Confirm the contents of the dialog box and click [OK].

When [Generate Readme.txt as a summary file in the project directory] checkbox is checked, the project information
displayed on the [Summary] dialog box will be stored in the project directory under the text file name "Readme.txt".

New Project-5/5-Changing the File Names to be Created ™ 2l x|

The following source files will be

generated:
File M ame | Eut... | D escription
dbact C Setting of B.F Section
[l I Program of Low lewvel
oz C Program of 1/0 Streamr
zhirk, i Program of shrk,
intprg C |rterrupt Program
wecttbl C Initialize of Wector Tab
wect h Defirtion of Vectar
regetprg i Reset Program
tutorial o kd ain Program
lowsrc h Header file of /0 Stre
zhirk. h Header file of zhrk file
stackact h Setting of Stack area
4 | ha

| < Back I Ment | Finizh | Cancel |

Figure2.6 New Project Step 5 Dialog Box

Rev.4.00 2007.02.02 2-6
REJ05B0463-0400
RENESAS



Section 2 Procedure for Creating and Debugging a Program

(7) Other

Summary ﬂﬁl
Froject Summary:
-------- FROJECT GEMERATOR ------- -
FROJECT HAME : tutarial
PROJECT DIRECTORY : C:5Hew3stutonalstutanal
CPU SERIES : SH-1

TOOLCHAIM MARME : Fenezaz SuperH RISC engine St
TOOLCHAIM WERSIOM : 9000
GEMERATION FILES :
C:\Hew3stutarialhtutorialhdbzct o
Setting of B.F Section
C:AHew 3 tutonalstutorialslowlel src
Frogram of Low lewvel
C:\Hew 3 tutonalytutorialslowsre. o
Program of 140 Stream
C:5HewIstutonal tutonalhsbrk. o
Program of zbrk,
C:\Hew 3 tutonalstutorialsintprg. o
[nterrupt Proaranm

C:hHew3htutonalstutonialvwecttbl. o _ILI
1| | 3

Click OF. to generate the project or Cancel to abort,

[¥ Generate Readme.txt az a summay file in the praject directary

Cancel |

Figure2.7 Summary dialog box

If demonstration is selected from Project Type, low-level library sample that can be used at simulator debugging will be

embedded. The files to be embedded are as follows.

e lowlvl.src (Standard I/O Sample Assembler List)
e lowsrc.c (Low-level Library Source File)
e lowsrc.h (Low-level Library Header File)
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2.2 Introduction of Sample Program (SH-1, SH-2, SH-2E, SH-2A, SH2A-FPU, SH2-DSP)

In this subsection, a sample program with the structure shown in figure 2.8 is used to explain the actual procedure for
creating a program. The development environment is described in table 2.1.

( main ) ( IRQO )

Initialization Interrupt processing

_INITSCT a=PB.DR.WORD

Section initialization Port B data call

init_peripheral PC.DR.BYTE=padata

Register initialization Port C data set

Main processing

N
a=0 SLEE RTE

Motor

Motor revolution

Figure 2.8 Sample Program Structure

Table 2.1 Sample Program Development Environment

(0N UNIX
CPU SH-1
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221 Creating a Vector Table

A vector table creation program appears in figure 2.9. For details on creating vector tables, refer to section 3.1.3, Creating
Vector Tables.

Figure 2.9 shows the same program as in figure 2.10, written in assembly language.

/**************************************************************/

/* file name "vect.c" */
/**************************************************************/
extern void main (void) ;
extern void inv_inst (void) ;

extern void IRQO (void) ;

voild (* const vec_tablel[]) (void)={
mnain,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,
0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,
inv_inst, 0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,
0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,
IRQO

Figure2.9 Vector Table Creation Program (C Language Version)
The vector table for the SH-1 appearsin table 2.2.
Upon power-on reset, the function main is started. At this time the stack pointer is set to 0.

The start address of the function inv_inst is set to the vector number 32, and the start address of the function IRQO is set to
the vector number 64. These are start vector numbers for the user vector and for external interrupts, respectively.

Table 2.2 Exception Processing Vector Table

Exception Source Vector Number Vector Table Address Offset

Power-on reset PC 0 H'00000000 to H'00000003
SP 1 H'00000004 to H'00000007

Manual reset PC 2 H'00000008 to H'0000000B
SP 3 H'0000000C to H'0000000F

Trap instruction (User vector) 32 H'00000080 to H'00000083
63 H'000000FC to H'000000FF

Interrupt IRQO 64 H'00000100 to H'00000103
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.SECTION VECT,DATA,ALICGN=4

. IMPORT _main

. IMPORT _inv_inst

. IMPORT _TRQO

.DATA.L _main ;_main start address set to vector number 0
.DATA.L H'0000000 ;SP initial value set to vector number 1

.ORG H'0080

.DATA.L _inv_inst ;_inv_inst start address set to vector number 32
.ORG H'0100

.DATA.L _IRQO ;_IRQO start address set to vector number 64
.END

Figure 2.10 Vector Table Creation Program (Assembly L anguage Version)

In the assembly language program, an underscore” " is prefixed to the external names of the C language program.

222 Creating a Header File

Figure 2.11 shows a header file used in common by all the sample programs. By defining IPRA and other 1/0 ports, the
1/O ports can be accessed by name as if they were variables.

/***********************************************************************/
/* file name "7032.h" (Extract) */
/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k***‘k*‘k*‘k***‘k*‘k*‘k*******‘k*****‘k*‘k*‘k***‘k*‘k*‘k***‘k*‘k*****/
/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k***‘k*‘k*‘k***‘k*‘k*‘k*******‘k*****‘k*‘k*‘k***‘k*‘k*‘k***‘k*‘k*****/
/* Definitions of I/O Registers */
/***********************************************************************/
struct st_intc { /* struct INTC */
union { /* TIPRA */
unsigned short WORD;/*Word Access */
struct { /* Bit Access */
unsigned char UU:4; /* TIRQO */
unsigned char UL:4; /* TIRQ1 */
unsigned char LU:4; /* TIRQ2 */
unsigned char LL:4; /* IRQ3 */
} BIT; /* */
} IPRA; /* */
union { /* IPRB */
unsigned short WORD; /* Word Access */
struct { /* Bit Access */
unsigned char UU:4; /* TIRQ4 */
unsigned char UL:4; /* IRQ5 */
unsigned char LU:4; /* TIRQ6 */
unsigned char LL:4; /* IRQ7 */
} BIT; /* */
} IPRB; /* */
Yoo /% */
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#define INTC (*(volatile struct st_intc *)0x5FFFF84)

/* INTC Address */
/***********************************************************************/
/* Timer registers */

/***********************************************************************/

struct st_itu0 { /* struct ITUO */
union { /* TCR */
unsigned char BYTE; /* Byte Access */
struct {/* Bit Access */
unsigned char :1; /* */
unsigned char CCLR :2; /* CCLR */
unsigned char CKEG :2; /* CKEG */
unsigned char TPSC :3; /* TPSC */
} BIT; /* */
} TCR; /* */
Yoo /* o/

#define ITUO (* (volatile struct st_itul0 *)O0x5FFFF04)
/* ITUO Address */

/***********************************************************************/

/* PORT registers */

/***********************************************************************/

struct st_pa { /* struct PA */
union { /* PADR */
unsigned short WORD; /* Word Access */
struct { /* Byte Access */
unsigned char H; /* High */
unsigned char L; /* Low */
} BYTE; /* */
struct { /* Bit Access */
unsigned char B15 :1; /* Bit 15%*/
unsigned char B14 :1; /* Bit 14*/
unsigned char B13 :1; /* Bit 13*/
unsigned char B12 :1; /* Bit 12*/
unsigned char B11l :1; /* Bit 11*/
unsigned char B10 :1; /* Bit 10*/
unsigned char B9 :1; /* Bit 9*/
unsigned char B8 :1; /* Bit 8*/
unsigned char B7 :1; /* Bit 7%/
unsigned char B6 :1; /* Bit 6*/
unsigned char B5 :1; /* Bit 5%/
unsigned char B4 :1; /* Bit 4%/
unsigned char B3 :1; /* Bit 3*/
unsigned char B2 :1; /* Bit 2%/
unsigned char Bl :1; /* Bit 1*/
unsigned char B0 :1; /* Bit 0*/
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} BIT; /* */
} DR; /* */
Yioo/* o/
#define PB (*(volatile struct st_pa *)0x5FFFFC2)
/* PB Address */
struct st_pc { /* struct PC */
union { /* PCDR */
unsigned char BYTE; /* Byte Access */

struct { /* Bit Access */

unsigned char B7 :1; /* Bit 7
unsigned char B6 :1; /* Bit 6
unsigned char B5 :1; /* Bit 5
unsigned char B4 :1; /* Bit 4
unsigned char B3 :1; /*  Bit 3
unsigned char B2 :1; /* Bit 2
unsigned char Bl :1; /* Bit 1
unsigned char BO :1; /* Bit 0
}  BIT; /* */
} DR; /* */

Yoo o/% o/

1 v 1 u ] X
#define PC (* (volatile struct st_pc *)O0x5FFFFD1)

/* PC Address */
/***********************************************************************/
/* file name "sample.h" */
/***********************************************************************/
/***********************************************************************/
/* Timer registers */

/***********************************************************************/

struct tcsr { /* */

short OVF :1; /*TCSR struct OVF bit
short WTIT :1; /* WTIT bit
short :3; /* work area
short CKS2 :1; /* CKS2 bit
short CKS1 :1; /* CKS1 bit
short :9; /* work area */
Yoo /**/
#define TCSR_FRT (*(volatile unsigned short *)0x5FFFFBS8)
/*xox/
#define TCSR__FRT (*(volatile struct tcsr *)0x5FFFFBS8)
VA
extern void motor ( void ); /* motor module */

extern void _INITSCT( void );
/* section initialize module */
extern void init_peripheral (void) ;

/* peripheral initialize module */

*/
*/
*/
*/
*/
*/
*/
*/

*/
*/

*/

*/
*/

Figure2.11 Header File
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2.2.3 Creating the Main Processing Program

The main processing program is shown in figure 2.12. Here the function main, which is started upon power-on reset, and
the function motor, which is called continuously until an interrupt occurs, are defined.

/***********************************************************************/

/* file name "sample.c" */

/***********************************************************************/

#include "7032.h"

#include "sample.h"

#include <machine.h> /*Define embedded function sleep */
const short padata=0x3; /* C section */

short a=0; /* D section */

int work; /* B section */

/***********************************************************************/

/* main module *x/

/***********************************************************************/

void main( void )

{
_INITSCT() ; /* Initialize each section */
init_peripheral () ;
while(!a) motor();
sleep();
}

/***********************************************************************/

/* motor module */

/***********************************************************************/

vold motor ( void ) /*Call until an interrupt occurs */
{

return;
}

Figure2.12 Main Processing Program

In the function main, _INITSCT and init_peripheral are called to perform section initialization and internal register
initialization. Then the program waits for a change in the value of the global variable a. During this time, the function
motor is continuously called. If the value of a changes from zero, the low-power consumption state is entered.
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2.2.4 Creation of the Initialization Unit

Figure 2.13 shows an assembly language program which sets the values for external names used in section initialization;
Figure 2.14 shows a C language program which performs section initialization and register initialization.

PEE R Sk S b I R S S I R S I I R I I I
l

; file name "sct.src" *

B e T T R
.SECTION B,DATA,ALIGN=4
.SECTION R,DATA,ALIGN=4
.SECTION D,DATA,ALIGN=4

; any sections to be added are listed here

.SECTION C,DATA,ALIGN=4

__B_BGN: .DATA.L (STARTOF B)
__B_END: .DATA.L (STARTOF B)+(SIZEOF B)
__D_BGN: .DATA.L (STARTOF R)
__D_END: .DATA.L (STARTOF R)+(SIZEOF R)
__ D_ROM: .DATA.L (STARTOF D)

.EXPORT __B_BGN
.EXPORT __B_END
.EXPORT __D_BGN
.EXPORT __D_END
.EXPORT _D_ROM
.END

Figure 2.13 Initialization Program (Assembly L anguage Part)
The start and end addresses of the B section and D section are defined.

At compiletime, if section options are not used to specify section names, the C/C++ compiler automatically assigns the
following names.

Program section: P
Constants section: C
Initialization data section: D
Uninitialized data section: B

The R section shows the RAM area to which initialization data area on the ROM is copied using the ROM support
functions of the linkage editor. For more information on the ROM support functions of the linkage editor, refer to section
3.15.2 (1) , ROM Support Function.

STARTOF is an operator which determines the start address of sections, using the format " STARTOF <section name>".

SIZEOF is an operator which determines the size of a section, in byte units, using the format " SIZEOF <section name>".
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/**********************************************************************/

/* file name "init.c" */
/**********************************************************************/
#include "7032.h"
#include "sample.h"

/**********************************************************************/

/* section initialize module */
/**********************************************************************/
extern int *_B_BGN, *_B_END, *_D_BGN, *_D_END, *_D_ROM;
void _INITSCT (void)
{
register int *p, *q;
for (p=_B_BGN; p<_B_END; p++)
*p=0;
for (p=_D_BGN; g=_D_ROM, p<_D_END; p++,d++)
*p=*q;
}

/********************************************************************* /

/* peripheral initialize module *

/********************************************************************* /

void init_peripheral (void)

{

INTC.IPRA.WORD = 0x3000; /* Initialize IPRA */
ITUO.TCR.BYTE = 0x02; /* Initialize TCRO */
TCSR_FRT = 0x5A01; /* Initialize TCSR */
PB.DR.WORD = 0x80; /* Initialize PORT */

Figure2.14 Initialization Program (C Language Part)

In the section initialization module INITSCT, B section zero-clearing and copying of ROM initialization datato RAM
are performed based on the section address specified in sct.src. Theint type specifier is used, but if the sizeis other than
4n bytes, char should be used.

In the internal register initialization moduleinit_peripheral, the following settings are performed.

e Intheinterrupt priority level register A, the IRQO interrupt priority level is set to 3.

e Inthetimer control register O, clearing of the timer counter O of the 16-bit integrated timer pulse unit is forbidden,
counting is set for the rising edge, and internal clock is set to count at ¢/4.

e Thetimer counter for the watchdog timer is set to 0x01.

e Port B isset to 0x80.
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225 Creating Interrupt Functions

Figure 2.15 shows interrupt functions. The external interrupt handler function IRQO and trap instruction function inv_inst
are defined.

/************************************************************************/

/* file name "int.c" */
EE IR R R I I S R I I R I I I I I 2 I I I R R I I R R I I I R R R e R S I I S I e E I I I S I R I 2 I I E I b I I b 2
/ /

#include "7032.h"

#include "sample.h"

extern const short padata; /* C section */
extern short a; /* D section */
extern int work; /* B section */

#pragma interrupt (IRQ0, inv_inst)

/************************************************************************/

/* interrupt module IRQO */
/************************************************************************/
void IRQO (void)
{
a = PB.DR.WORD;
PC.DR.BYTE = padata;
}

/************************************************************************/

/* interrupt module inv_inst */

/************************************************************************/

void inv_inst (void)
{

return;

Figure 2.15 Interrupt Functions

The function IRQO sets the global variable ato PB.DR.WORD (0x80) when an IRQO externa interrupt occurs. By this
means the CPU is put into alow-power consumption state.
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2.2.6

Creating a Batch Filefor aLoad Module

Figure 2.16 shows a batch file used to create an S-type load module (sample.mot).

Here
other

2.2.7

shcA-debugAsample.cAinit.cAint.c
#Compile C programs
asmshAsct.srcA-debug

#Assemble Assembly programs
shcA-debugA-section=c=VECTAvect.c
#Compile vector table creation programs
optlnkA-nooptA-subcommand=rom.sub
#Link using a subcommand file

rmA*.obj

#Remove object module files
Figure2.16 Batch Fileto Createa Load Module

vect.c is compiled into an independent file, and the option section=VECT is used to make it a section separate from
initialization data units. On linking it is alocated addresses starting from O.

Creating a Linkage Editor Subcommand File

Figure 2.17 shows a subcommand file (filename rom.sub) for the linkage editor used when creating load modules.

Sdebug
input sample,init, int,vect, sct
; Specify input files
library /user/unix/SHCV5.0/shclib.lib
; Specify a standard library
output sample.abs sample.abs ; Specify an output filename
rom D=R ; Specify ROM support options
start VECT/O0,P,C,D/0400,R,B/F0000000
; Specify the start addresses for each section
; Allocate section VECT starting from address 0

; Allocate sections P, C, D to the area starting from
address H'400

; Allocate sections R, B to the area starting from address

H'F0000000
form s ; Specify s-type format
list sample.map ; Specify memory map information output

Exit

Figure 2.17 Subcommand Filefor Linkage Editor
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2.3 Introduction of Sample Program (SH-3,SH3-DSP,SH-4,SH-4A, and SH4AL-DSP)

In this subsection, a sample program is introduced for the case of the SH7708. The sample program introduced here
performs processing from reset until execution is passed to the main() function. Thisis an example of the smallest
program necessary when the CPU is started.

231 Creating an Interrupt Handler

In contrast with the SH-1, SH-2, SH-2E, SH-2A, SH2A-FPU, and SH2-DSP, in the cases of the SH-3, SH3-DSP, SH-4,
SH-4A, and SH4 AL-DSP vector control in the event of an interrupt must in essence be specified in software.

Fixed addresses for interruptsin the SH-3 are set to the PC (program counter) for three different causes: reset, exceptions,
and interrupts. Hence routines to determine the interrupt factor, and for branching to interrupt processing for each factor,
must be written at each of these addresses as interrupt handlers.

Individual handlers are explained in detail below. Here an example is given in which the vector base register (VBR) is
fixed at H'00000000, and the memory management unit (MMU) is unused.

(1) Reset handler (address H'00000000)

At power-on or manual reset, the PC is set to H'a0000000. Because addresses H'00000000 and H'a0000000 correspond to
acommon physical address, the program is placed at H'00000000. Here the following steps are performed:

e Exception judgment is performed by EXEVT
e The processing routineis called from the vector table
Processing is shown in figure 2.18.

PR R I I R R I I I R IR I R I I R R I I R R R R I I I R S R I I R R S
7

; file name "reset.src"
,.********************************************************************
; SH7708 Reset handler Routine

. IMPORT _vecttbl

. IMPORT _stacktbl

.SECTION VECT,CODE, LOCATE=H'0
__reset:
,.************************************************************
; You should initialize the stack RAM area by BSC
; before set the stack pointer "R15"
;************************************************************
; exsample ) AREAl (CS1l) -> STACK RAM
; AREAL
; Bus size ->16bit
; D23-D16 ->not PORT
; wailt 3 state
; BCR2>> PORTEN:A1S70:A1S7Z0

; 0:1 :0

; >> BCR2=0x3fff8
MOV.L BSCR2, RO
MOV.L #H'3f£f£8,R1

MOV .W R1, QRO
; WCR2>> Al1-2W1:A1-2WO0
;101
; >> WCR2=0xffff
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MOV.L WCR2, RO

MOV.L #H'f£fff,R1

MOV.W RI1,@RO
P A

MOV.L VECTadr,R1

MOV.L STACKadr,R2

MOV.L EXPEVT, RO
MOV.L @RO, RO
CMP/EQ #0,R0 ; POWER ON RESET
BT PON_RESET
CMP/EQ #H'20,R0
BT MANUAL_RESET
; 1f( EXPEVT != RESET)
; while(1);

LOOP

BRA LOOP

NOP

PON_RESET
MOV . L @(0,R1),R1 ;set function
MOV.L @(0,R2),R15 ;set stack pointer
JMP @R1
NOP

MANUAL_RESET
MOV.L @(4,R1),R1 ;set function
MOV.L @(4,R2),R15 ;set stack pointer
JMP @R1
NOP
.ALIGN 4

VECTadr .DATA.L _vecttbl

STACKadr .DATA.L _stacktbl

EXPEVT .DATA.L H'ffffffd4

BSCR2 .DATA.L H' ffffffe2

WCR2 .DATA.L H' ffffffe6
.END

Figure 2.18 Reset Handler Program

(2) Genera exception-processing handler (VBR+H'100)

The exception factor code isread from EXPEVT.

The processing function (vector function) for this factor is read from the vector table.
The terminate routine is set.

Execution jumps to the vector function.

In this case, RTE instructions are used in order to jump to the vector function. Here the PR register value is changed
immediately before jumping to the vector function, such that on returning from the vector function, control is passed to the
terminate routine. As PR during vector function processing is the terminate routine, it is necessary to return the vector
function by executing RTS. For this reason, when defining the vector function, do not use ‘#pragma interrrupt’.

(3) VBR+H'400 TLB miss exception handler

Because MMU is unused, thisis not included.

(4) VBR+H'600 interrupt handler
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e Theinterrupt factor codeisread from INTEVT.

e The processing function (vector function) for this factor is read from the vector table.
e Theinterrupt mask level for thisfactor is set from the interrupt mask table.

e Theterminateroutineis set.

e Execution jumps to the vector function.

This processing is in essence the same as for general exception handlers; on returning from the vector function, control is
passed to the terminate routine.

PR R R I kR Ik S S R Rk R R I R SRR Rk kb o S R R SRR R I S bk R
l

; FILE :vhandler.src

IR R I i I I kS R I R i S I R R S I R Ik I Sk R S S Rk I Rk b Sk
i

.include "env.inc"

.include "vect.inc"

IMASKclr: .equ H'FFFFFFOF

RBBLclr: .equ H'CFFFFFFF

MDRBBLset : .equ H'70000000
.import _RESET_Vectors
.import _INT Vectors
.import _INT_MASK

PR R R I I R I Ik S I I R R R S S R R R R Rk S R R R R I R Ik bk e
l

;* macro definition

IR R i I I kI e S R I S i S S R R S I Rk R S I Sk R S S SRk I I S Sk S Sk
l

.macro PUSH_EXP_BASE_REG

stc.l ssr,@-rl5 ; save ssr
stc.l spc,@-rl5 ; save spc
sts.l pr,@-rl5 ; save context registers
stc.l r7_bank,@-rl5

stc.l r6_bank,@-rl5

stc.l r5_bank,@-rl5

stc.l r4_bank,@-rl5

stc.l r3_bank,@-rl5

stc.l r2_bank,@-rl5

stc.l rl_bank,@-rl5

stc.l rO_bank,@-rl5

endm

.macro POP_EXP_BASFE_REG

ldc.1l @rl5+,r0_bank ; recover registers

ldc.1l @rl5+,rl_bank
ldc.1l @rl5+,r2_bank
ldc.1l @rl5+,r3_bank
ldc.1l @rl5+,r4d_bank
ldc.1l @rl5+,r5_bank
ldec.1l @rl5+,r6_bank
ldc.1l @rl5+,r7_bank
lds.1l @rl5+,pr
ldc.1l @rl5+,spc
ldc.1l @rl5+,ssr
.endm

R R R I Ik R R Ik R SRk bk R R I R R Rk I Rk ek b b b Sk R Rk ik e
l

; reset
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PR R I S I I I R I S I R I I S R R I S S I I I I I R S S I I S
7

.section RSTHandler, code

_ResetHandler:

mov.l #EXPEVT,r0

mov.l @r0,r0

shlr2 r0

shlr r0

mov.l #_RESET_Vectors,rl

add rl,r0

mov.l @r0,r0

jmp @ro0

nop

PR I R I I S R I I R S I R I I S R I I I S S I I S I I R R S S I S
7

; exceptional interrupt
,.*******************************************************************
.section INTHandler, code
.export INTHandlerPRG
INTHandlerPRG:
_ExpHandler:
PUSH_EXP_BASE_REG

mov.l #EXPEVT,r0 ; set event address

mov.l @r0,rl ; set exception code

mov.l #_INT Vectors,r(0 ; set vector table address

add #-(h'40),rl ; exception code - h'40

shlr2 rl1

shlr rl

mov.l @(r0,rl),r3 ; set interrupt function addr
mov.l #_INT_MASK,r0 ; interrupt mask table addr
shlr2 ril

mov.b @(r0,rl),rl ; interrupt mask

extu.b rl,rl

stcsr,r0 ; save sr

mov.l # (RBBLclr&IMASKclr),r2 ; RB,BL,mask clear data
andr2,r0 ; clear mask data

or rl,r0 ; set interrupt mask
1ldc r0, ssr ; set current status

ldc.1l r3,spc

mov.l #__int_term,r0 ; set interrupt terminate
1ds r0, pr

rte

nop

.pool

PR R R R S I R R S R R I I R R R R I
7

; Interrupt terminate

PRk b R I R R R R Ik R R I b I R R I R R R I bk Rk R S R SRR R I
7
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.align 4

__int_term:
mov.l #MDRBBLset,r0 ; set MD,BL,RB
ldc.1l 1rO0,sr ;
POP_EXP_BASE_REG
rte ; return
nop

.pool

IR R I kS R I S i S I kR I I Rk R i Sk I R S Rk I Sk b Sk
7

; TLB miss interrupt
,.*******************************************************************
.org H'300
_TLBmissHandler:
PUSH_EXP_BASE_REG

mov.l #EXPEVT,r0 ; set event address

mov.l @r0,rl ; set exception code

mov.l #_INT Vectors,r0 ; set vector table address
add#-(h'40),rl1 ; exception code - h'40

shlr2 rl

shlr rl

mov.l @(r0O,rl),r3 ; set interrupt function addr
mov.l #_INT_MASK,r0 ; interrupt mask table addr
shlr2 rl

mov.b @(r0,rl),rl ; interrupt mask

extu.b rl,rl

stcsr,r0 ; save sr

mov.l # (RBBLclr&IMASKclr),r2 ; RB,BL,mask clear data
andr2,r0 ; clear mask data

or rl,r0 ; set interrupt mask
1ldcr0, ssr ; set current status

ldc.1 r3,spc
mov.l #_ _int_term,xr0 ; set interrupt terminate

lds r0,pr

rte

nop

.pool

PR I I R I R R R R R R I I I R e R I I I 2 I I I R I I R I I R R I I R I I I I I I R S I b b I I R h S 2 2 kS 2
i
; IRQ
IS SRS SRR R SRR R R EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE DD DD RN RIS
;

.org H'500
_IRQHandler:

PUSH_EXP_BASE_REG
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mov.l #INTEVT,r0

mov.l @Qro0,rl

mov.l #_INT Vectors,r0
add#-(h'40),rl

shlr2 rl

shlr rl

mov.l @(r0,rl),r3

mov.l #_INT MASK,r0
shlr2 rl
mov.b @(r0,rl),rl

extu.brl,rl

stcsr,r0

mov.l # (RBBLclr&IMASKclr),r2

andr2,r0
or rl,r0

ldcr0, ssr

ldc.1l 1r3,spc
mov.l #__ int_term,r0

1ds r0,pr

rte

nop

.pool
.end

set event address
set exception code
set vector table address

exception code - h'40

set interrupt function addr

interrupt mask table addr

interrupt mask

save sr

RB, BL,mask clear data

clear mask data

set interrupt mask

set current status

set interrupt terminate

Figure 2.19 Interrupt Handler Program

Note: Theinclude files“env.inc" and "vect.inc" are automatically generated by HEW when an SH3 project is created.

2.3.2 Creating the Vector Table

(1) Vector table <vect.c>

Here the vector table, the interrupt priority table, and the TRAPA function table are described. The names for each factor

areregistered in this table, and actual user-created function names are given in the vect7708.h header file.

/****************************************************************/

/* FILE NAME "vect.c" */

/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k***‘k*‘k***‘k***‘k*‘k***‘k*‘k*‘k*‘k/

#include "vect7708.h"

/****************************************************************/

/* ALLOCATE STACK AREA */
/****************************************************************/
#pragma section STK /* SECTION name "BSTK" */

long stack[STACK_SIZE];

#pragma section

/****************************************************************/

/* ALLOCATE DEFINITION TABLE */

/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k***‘k*‘k***‘k***‘k*‘k***‘k*‘k*‘k*‘k/
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const void *stacktbl[]={
STACK_PON,
STACK_MANUAL

}i

/****************************************************************/

/* ALLOCATE VECTOR TABLE (EXPEVT or INTEVT CODE H'000-H'5a0) */

/****************************************************************/

void (*const vecttbl[]) (void) = {

/* EVT KIND CODE REG

*/
RESET_PON, /* PON RESET H'000 EXPEVT
RESET_MANUAL, /* MANUAL RESET H'020 EXPEVT
TLB_MISS_READ, /* TLB MISS(R) H'040 EXPEVT
TLB_MISS_WRITE, /* TLB MISS (W) H'060
TLB_1ST PAGE, /* H'080
TLB_PROTECT_READ, /* H'0a0
TLB_PROTECT_WRITE, /* H'0cO
ADR_ERROR_WRITE, /* H'0e0l
ADR_ERROR_WRITE, /* H'100
RESERVED, /* H'120 --———-—-
RESERVED, /* H'140 ------
TRAP, /* H'160 (with TRA)
ILLEGAL_INST, /* H'180 EXPEVT
ILLEGAL_SLOT, /* H'1la0 EXPEVT
NMI, /* H'1lcO INTEVT
USER_BREAK, /* H'leO EXPEVT
IRQ15, /* H'200 INTEVT
IRQ14, /* H'220 INTEVT
TRQ13, /* H'240 INTEVT
TRQ12, /* H'260 INTEVT
TRQ11, /* H'280 INTEVT
IRQ10, /* H'2a0 INTEVT
IRQO, /* H'2c0  INTEVT
IROS, /* H'2e0  INTEVT
TRQ7, /* H'300 INTEVT
IRQ6, /* H'320 INTEVT
IRQ5, /* H'340  INTEVT
IRQ4, /* H'360 INTEVT
IRO3, /* H'380 INTEVT
IRO2, /* H'3a0 INTEVT
TIRQ1, /* H'3cO INTEVT
RESERVED, /* H'3e0 ---—---
TMUO_TUNIO, /* H'400 INTEVT
TMU1_TUNI1, /* H'420 INTEVT
TMU2_TUNIZ2, /* H'440 INTEVT
TMU2_TICPIZ2, /* H'460 INTEVT
RTC_ATI, /* H'480 INTEVT
RTC_PRI, /* H'4a0  INTEVT
RTC_CUI, /* H'4cO INTEVT
SCI_ERT, /* H'4e0 INTRVT
SCI_RXI, /* H'500 INTRVT
SCI_TXT, /* H'520 INTRVT

*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
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SCI_TET,

WDT_ITI,

REF_RCMI,

DEF_RPVI,

RESERVED
Yi

/*
/*
/*
/*

H'540
H'560
H'580
H'5a0

INTRVT
INTEVT
INTEVT
INTEVT

/***************************************************************/

/* ALLOCATE INTERRUPT PRIORITY TABLE INTEVT H'lcO-H'5a0

/***************************************************************/

const char imasktbl[]={
15<<4, /*
IP_RESERVED, /*
*/
15<<4, /*
14<<4, /*
13<<4, /*
12<<4, /*
11<<4, /*
10<<4, /*
9<<4, /*
8<<4, /*
T<<4, /*
6<<4, /*
5<<4, /*
4<<4, /*
3<<4, /*
2<<4, /*
1<<4, /*
IP_RESERVED, /*
IP_TMUO, /*
IP_TMU1, /*
IP_TMU2, /*
IP_TMU2, /*
IP_RTC, /*
IP_RTC,
IP_RTC,
IP_SCT, /*
IP_SCTI,
IP_SCI,
IP_SCI,
IP_WDT, /*
IP_REF, /*
IP_REF, /*
IP_RESERVED
}s
void (*const trap tbl[]) (void)={
TRAPA_O,
TRAPA_1,
TRAPA_2,
TRAPA_3,
TRAPA_4,

*/

NMI level 16 (IMASK=0-15)

(IRLO0OO0O)
(IRLO0OO1)
IRQ13 (IRLOO10)
(IRLOO11)
(IRLO10O)
(IRLO101)
IRLO110)
IRLO111)
IRL1000)
IRL1001)
IRL1010)
IRL1011)
IRL1100)
IRL1101)
IRL1110)

—
)
0
o

TICPI2
RTC ATI

SCI ERI

wDT ITI
REF RCMI
REF ROVI

*/
*/
*/
*/

*/

*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/

*/

*/
*/
*/
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TRAPA_5,
TRAPA_6,
TRAPA_7,
TRAPA_S,
TRAPA_9,
TRAPA_10),
TRAPA_11,
TRAPA_12,
TRAPA_13,
TRAPA_14,
TRAPA_15

Figure2.20 Vector Table
(2) Vector function registration <vect7708.h>

The actual user-defined function names and other parameters are set. If interrupt processing functions are added, this area
is changed.

Processing here includes:

e Definition of stack size
e Definition of vector function names for each factor
e Setting of interrupt priorities (values set to IPRA and IPRB)

A function called halt is here defined for unused vectors. The user functions themselves must be defined as interrupt
functions using a #pragma interrupt declaration. Also, if afunction is registered, the extern declaration for the function
must appear in thisfile.

/*****************************************************************/

/* FILE NAME "vect7708.h" */

/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k***‘k*‘k*‘k*‘k***‘k*‘k***‘k***‘k*‘k***/

/*****************************************************************/

/* STACK SIZE definition */
/*****************************************************************/
#define STACK_SIZE (0x4096/4) /* 4096 byte */
#define STACK_PON (&stack [STACK_SIZE])

#define STACK_MANUAL (&stack [STACK_SIZE])

extern long stack[];

/*****************************************************************/

/* RESET FUNCTION definition */

/*~k*~k*******~k*~k*~k*~k*~k*********************************************/

#define RESET_PON init /* PON RESET H'000  EXPEVT */
#define RESET_MANUAL  init /* MANUAL RESET H'020  EXPEVT */
/*****************************************************************/

/* INTERRUPT FUNCTION definition */
/*~k*******~k*~k*~k*~k*~k**************************************************/
#define  TLB_MISS_READ halt /* TLB MISS(R) H'040 EXPEVT */
#define  TLB_MISS_WRITE halt /* TLB MISS(W) H'060 EXPEVT */
#define  TLB_1ST_PAGE halt /* H'080 EXPEVT */
#define  TLB_PROTECT_READ halt /* H'0a0 EXPEVT */
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#define
#define
#define
/*#define
/*#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
/*#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define

TLB_PROTECT WRITE
ADR_ERROR_WRITE
ADR_ERROR_WRITE
RESERVED
RESERVED
TRAP
ILLEGAL_INST
ILLEGAL_SLOT
NMI
USER_BREAK
IRQ15

IRQ14

IRQ13

IRQ12

IRQ11

IRQ10

IRQ9

IRQ8

IRQ7

IRQ6

IRQ5

IRQ4

IRQ3

IRQ2

IRQ1
RESERVED
TMUO_TUNIO
TMU1_TUNI1
TMU2_TUNI2
TMU2_TICPI2
RTC_ATI
RTC_PRI
RTC_CUI
SCI_ERI
SCI_RXI
SCI_TXI
SCI_TEI
WDT_ITI
REF_RCMI
DEF_RPVI
RESERVED

extern void init (void) ;

extern void halt (void) ;

extern void _trap(void

extern void irqgl5(void

)
).

7

halt
halt
halt
halt
halt
trap
halt
halt
halt
halt
irglh
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt
halt

*/
*/

/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
*//*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*

H'0cO
H'0eO
H'100
H'120
H'140
H'160
H'180
H'la0
H'1lcO
H'leO
H'200
H'220
H'240
H'260
H'280
H'2a0
H'2c0
H'2e0
H'300
H'320
H'340
H'360
H'380
H'3a0
H'3c0
H'3e0
H'400
H'420
H'440
H'460
H'480
H'4a0
H'4cO
H'4e0
H'500
H'520
H'540
H'560
H'580
H'5a0

EXPEVT
EXPEVT
EXPEVT

(with TRA)
EXPEVT
EXPEVT
INTEVT
EXPEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTEVT
INTRVT
INTRVT
INTRVT
INTRVT
INTEVT
INTEVT
INTEVT

*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/

/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k***‘k*‘k***‘k***‘k*‘k***‘k*‘k*‘k*‘k**/

/* INTERRUPT MASK definition

/********************************************************************/

#define IP_TMUO (0<<4)
#define IP_TMU1 (0<<4)
#define IP_TMU2 (0<<4)

*/
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#define IP_RTC (0<<4)
#define IP_SCI (0<<4)
#define IP_WDT (0<<4)
#define IP_REF (0<<4)

#define IP_RESERVED (15<<4)

/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k***‘k*‘k***‘k***‘k*‘k***‘k*‘k*‘k*‘k**/

/* IPRA,IPRB definition */
/********************************************************************/
#define WORD_IPRA ((IP_TMUO<<12) | (IP_TMU1l<<8) | (IP_TMU2<<4) | IP_RTC)
#define WORD_IPRB ((IP_WDT<<12) | (IP_REF<<8) | (IP_SCI<<4)10)

extern void set_ip(void);

extern long stack[];

/********************************************************************/

/* TRAPA system call definition
*/

/********************************************************************/

#define TRAPA_O halt
#define TRAPA_1 halt
#define TRAPA_2 halt
#define TRAPA_3 halt
#define TRAPA_4 halt
#define TRAPA_S5 halt
#define TRAPA_6 halt
#define TRAPA_7 halt
#define TRAPA_S halt
#define TRAPA_9 halt
#define TRAPA_10 halt
#define TRAPA_11 halt
#define TRAPA_12 halt
#define TRAPA_13 halt
#define TRAPA_14 halt
#define TRAPA_15 halt /*#15(#0F) should be Exception routine(Illegal use )*/

Figure 2.21 Vector Function Name Definitions

2.3.3 Creating the Header File

The header file common to the sample program is shown below.

/********************************************************************/
/* file name "7700s.h" (Extract) */
/********************************************************************/
struct st_intc { /* struct INTC */
union { /* ICR */

unsigned short WORD; /* Byte Access */

struct { /* Bit Access */

unsigned short NMIL:1; /* NMIL */

unsigned short 165 /* */

unsigned short NMIE:1; /* NMIE */

} BIT; /* */

} ICR; /* */

union { /* IPRA */
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I

unsigned short WORD;

struct

}

union {

{

unsigned short
unsigned short
unsigned short

unsigned short

}

BIT;
IPRA;

unsigned short WORD;

struct

char
unsigned int
unsigned int

unsigned int

{

unsigned short
unsigned short
unsigned short

unsigned short

}

BIT;
IPRB;
wkl[234];

TRA;
EXPEVT;
INTEVT;

union un_ccr {

Y

#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define

SCI
TMU
TMUOQ
TMU1
T™U2
RTC
INTC
BSC
CPG
UBC
MMU
CCR

unsigned int

struct {

unsigned
unsigned
unsigned
unsigned
unsigned
unsigned
unsigned

}

*(volatile

* (volatile

*(volatile

*(volatile

*(volatile

* (volatile

* (volatile

* (volatile

*(volatile

*(volatile

*(volatile

*

(*(
(*(
(*(
(*(
(*(
(*(
(*(
(*(
(*(
(*(
(*(
(*(

volatile

int
int
int
int
int
int

int

struct
struct
struct
struct
struct
struct
struct
struct
struct
struct
struct

union

LONG;

RA

CF
CB
WT
CE
BIT;

[ )

st_sci
st_tmu
st_tmul
st_tmul
st_tmu?2
st_rtc
st_intc
st_bsc
st_cpg
st_ubc
st_mmu

un_ccr

/*
/*
H /*
/*
/*
; /*
/*
/*
/*
/*
/*
; /*
/*
/*
H /*
/*
/*
/*
/*
/*
/*
/*

Uuu:
UL:
LU:
LL:

[

UU:
UL:
LU:
LL:

[

/*

*

OxFFFFFE80
OxXFFFFFESOQ
OxXFFFFFE94
OxXFFFFFEAQ
OxFFFFFEAC
OxFFFFFECO
OxFFFFFEEOQ
OxXFFFFFF60
OxXFFFFFF80
OxXFFFFFF90
OxFFFFFFEOQ
*) OXFFFFFFEC

*
*
*

*

*
*
*
*

)
)
)
)
)
*)
)
)
)
)
)

*

)
)
)
)
)
)
)
)
)
)
)
)

Word
Bit

IRQO
IRQ1
IRQ2
IRQ3

IPRB

Word
Bit

IRQ4
IRQ5
IRQ6
IRQ7

TRA

EX

INTEVT

Access */
Access */
*/
*/
*/
*/
*/
*/
*/
*/
Access*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/
*/

Access

PEVT

union CCR */

/*
/*
/*
/*
/*
/*
/*
/*
/*
/*
/‘k
/‘k
/*
/*
/*
/*
/‘k
/‘k
/*
/*
/*
/*
/‘k

Long Access*/

Bi

SCI
TMU
TMU
TMU
TMU
RTC
INT
BSC
CPG
UBC
MMU
CCR

t

RA
0

CF
CB
WT
CE

Access

*/
*/
*/
*/
*/
*/
*/
*/

*/

*/
Address*/
Address*/

0 Address*/
1 Address*/
2 Address*/
Address*/

C Address*/
Address*/
Address*/
Address*/
Address*/
Address*/

Figure 2.22 Header File
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234 Creating the Initialization Part
After reset, the BSC and pointer are set, and control passes to the initialization function.

The initialization function sets interrupt priorities and initializes sections, and then passes control to the start of the user
function.

(1) Initialization function <init.c, cntrl.h>

e Setsinterrupt priorities

e Flushesthe cache

e Turnsthe cache on

e |nitializes sections

e Setsinterrupt masks

e Branchesto the user function

/****************************************************************/

/* file name "cntrl.h" */
/****************************************************************/
#include <machine.h>

#include "7700s.h"

/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k***‘k*‘k***‘k***‘k*‘k***‘k*‘k*‘k**/

/* control BL ,MD bit */

/****************************************************************/

#define BLoff () set_cr((get_cr()&0xefffffff))
#define BLon/() set_cr((get_cr () 10x10000000))
#define USRmode () set_cr((get_cr () 10x40000000))

/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k***‘k*‘k***‘k***‘k*‘k***‘k*‘k*‘k**/

/* cache control */

/****************************************************************/

#define CacheON () (CCR.BIT.CE=1)
#define CacheOFF () (CCR.BIT.CE=0)
#define CacheFLASH () (CCR.BIT.CF=1)

Figure 2.23 Macro Definition Program
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/****************************************************************/

/* file name "init.c" */
/****************************************************************/
#include <machine.h>

#include "cntrl.h"

void init (void)

{
set_ip();
CacheOFF () ;
CacheFLASH () ;
CacheON () ;
BLoff () ; /* BLOCK BIT OFF */
_INITSCT () ; /* section initialize */
set_imask (0) ; /* interrput priority 0 */
main () ; /* User main() routine */
halt(); /* halt () */

Figure 2. 24 Initialization Program (1)

RENESAS
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(8) Setting interrupt priorities <ipr.c>

IPRA and IPRB are used to set interrupt priorities for each interrupt factor defined in vect7708.h.

/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k***‘k*‘k***‘k***‘k*‘k***‘k*‘k*‘k*‘k***/

/* file name "ipr.c" */
/***************************************************************/
#include "7700s.h"
#include "vect7708.h"
void set_ip(void)
{

INTC.IPRA.WORD=WORD_TIPRA;

INTC.IPRB.WORD=WORD_TIPRB;

Figure 2.25 Program to Set Interrupt Priorities
(b) Section initialization <sect.src, initsct.c>
Initialization of sections allocated to RAM is performed.

The uninitialized data section B is cleared to O. Initialized data items are copied from section D in ROM to section R in
RAM. (initsct.c)

In addition, assembly-language code is necessary to acquire the section start address and size. (sct.src)

IR R b ik Ik Ik I S R I S i S I R R S I Rk R S I Sk R S S Rk I I S Sk S Sk
l

; file name "sct.src"
;*******************************************************************
.SECTION B,DATA,ALIGN=4
.SECTION R,DATA,ALIGN=4
.SECTION D,DATA,ALIGN=4
; If other section are existed , Insert here “.SECTION XXX”,
.SECTION C,DATA,ALIGN=4

__ B BGN: .DATA.L (STARTOF B)
__ B END: .DATA.L (STARTOF B) + (SIZEOF B)
__ D_BGN: .DATA.L (STARTOF R)
__ D_END: .DATA.L (STARTOF R)+ (SIZEOF R)
__ D_ROM: .DATA.L (STARTOF D)

.EXPORT __ B BGN

.EXPORT __B_END

.EXPORT __D_BGN

.EXPORT __D_END

.EXPORT __D_ROM

.END

Figure 2.26 Section Definition Program
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/**************************************************************/

/* file name "initsct.c" */

/**************************************************************/

extern int *_B_BGN, *_B_END, *_D_BGN, *_D_END, *_D_ROM;

void _INITSCT (void)
{
register int *p, *qg;
for (p=_B_BGN; p<_B_END; p++){
*p=0;
}
for (p=_D_BGN, g=_D_ROM; p<_D_END; p++, g++){
*p=*q;

Figure 2.27 Section Initialization Program

2.35 Creating the Main Processing Part and Interrupt Processing Part

Upon creating the functions main(), halt(), and irq15(), the above program can be linked.

void main (void)
{
/* user program description */

}
#pragma interrupt (halt, irglh)

void halt (void)
{
while (1) ; /* routine for error processing */
/* here left as an infinite loop */
}
void irgl5 (void)

{
/* IRQ15 processing program */

Figure 2.28 Main Processing Program
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2.3.6 Creating a Batch Filefor the Load Module

Figure 2.29 shows a batch file for creation of an S-type load module (sample.mot).

shcA-debugA-cpu=sh3Avect.cAinit.cAipr.cAinitsct.cAmain.c

#Compile C programs
asmshAsct . srcA-debugA-cpu=sh3
asmshAintr.srcA-debugA-cpu=sh3
asmshAreset . srcA-debugA-cpu=sh3

#Assemble Assembly programs
optlnkA-nooptA-subcommand=1nk. sub

#Link using a subcommand file
rmA* . obj

#Remove object module files

Figure 2.29 Batch Filefor Load Module Creation

2.3.7 Creating a Linkage Editor Subcommand File

Figure 2.30 shows a subcommand file (filename Ink.sub) for the linkage editor used when creating load modules.

Sdebug

input vect, init, ipr, initsct, main, intr, sct, reset
; Specify an input file

Library /user/unix/SHCV50/shc3npb.lib
; Specify a standard library

output sample.abssample.abs ; Specify output files
rom D=R ; Specify ROM support options
start P,C,D/10000,R,B,BSTK/04000000

; Specify the start address for each section.

; Do not specify an address for section VECT because
; the section VECT is assigned to absolute address section

; (assigned to address 0).

; Allocate sections P, C, and D to

; the area starting from address H’10000.
; Allocate sections R and B to the area

; starting from address H’'04000000.

form S ; Specify s-type format
list sample.map; Specify memory map information output
Exit

Figure 2.30 Subcommand Filefor Linkage Editor
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24 Debugging using Simulator Debugger

24.1 Setting Configuration

Execute the Simulator Debugger using the project that was created in section 2.1.1, Creating the Project for a Simulator
Debugger.

Select [Build Configurations...] from the [Option] menu to display the available environments. On the screen shown in
figure 2.32, select the environment you use. In this case, select [SimDebug SH-1].

Ez'ﬁtuturial - High-performance Embedded Workshop - [dbsct.c]
0+ File Edit Yew Project | Opkions Build Tools Mindow Help

O = | ﬁ |§ | & SuperH RISC engine Standard Toolchain. .. 0 e
T I Build Phases... ehug
e Build Configurations. .. |
Er Bl Ex B & 0 ¢ =
_ = Debug Sessions... kk
@ tutorial ;
; Debug Setkings. ..
=-[F tutorial
-3 Assembly sourc Radix M 200
o] lowklste T 5% NFQPRTPTIMN +Qatt ino ~F R B

Figure2.31 OptionsMenu

Build configurations:

ehlg ]
Feleaze Cancel |

SimDebug_SH-1
Bdd..

Eemowve |

Current configuration:

Debueg ;I

Figure 2.32 Build Configurations Dialog Box
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24.2 Allocating Memory Resour ces

The allocation of the memory resource is necessary to run the application being developed. When using the demonstration
project, the memory resource is allocated automatically, so check the setting.

e Sdect [Simulator->Memory Resource...] from the [Option] menu, and display the allocation of the current memory

resource.
simulator System r1_| El

Systam Memory |

Memory Map: '::'ﬂ! S| ¥g (S| Memory Besource:

R

Begin | End | Twpe |5.15.] Eegin | End | Attribute |
00000000 OS5FFFEFF  EXT 16: 1 00000000 DOOOTFEF  Read/rite
OSFFFFOD 05FFFFFF IO 16 1 D5FFFFOO OSFFFFFF  Fead/Miite
Q000000 OFFFDFFF  ROM 16 1 OFFFEODD  OFFFFFFF  Read/rite
OFFFEQDD OFFFFFFF RAM 21

10000000 FFFFFFFF EXT 16 1

oK | Cancel | Aol |

Figure2.33 Simulator -> Simulator System Dialog Box

The program areais allocated to the addresses H'00000000 to H'00007FFF. The stack areais allocated to the addresses
H'OFFFEO0O to H'OFFFFFFF, which can be read from or written to.

e Closethe dialog box by clicking [OK].

The memory resource can also be referred to or modified by using the [Simulator] tab on the [SuperH RISC engine
Standard Toolchain] dialog box. Changes made in either of the dialog boxes are reflected.
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24.3 Downloading a Sample Program
When using the demonstration project, the sample program to be downloaded is automatically set, so check the settings.

e Open the [Debug Setting] dialog box by selecting [Debug Settings...] on the [Option] menu.

Debug Settings K E3

T arget | Dptionsl

- [ | tutarial Target:
|5H-1 Simulator =]
Default Debug Format:
|Elf/Dwartz =
Download Modules:
File Mame | Offzet Address | Form: Add...
FCOMFIGDIR)NE[.. H'OO0000000 Elf/D
Eemoyve |
T i |
] e}
Bl ] |
+ | I3
Ok, I Cancel I

Figure 2.34 Debug Settings Dialog Box

e Filesto be downloaded is set in [Download Modules)].
e Closethe [Debug Settings] dialog box by clicking the [OK] button.
e Download the sample program by selecting [Download Modules->All Download Modules] from the [Debug] menu

244 Setting Simulated /0O
When the demonstration project is used, the simulated /O is automatically set, so check the setting.

e Open the [Simulator System] dialog box by selecting [Simulator->System] from the [Option] menu.

Simulator System

Systern l Memary I

CPU:

.
Bit size: Simulated 1/0 Addresss [ Enable

D32 {H'00000000 |
Endian: Execution M ode:

[Big Endian {Stop | Detail.
Clock R ate: Rezponze:

| |D'4DDDD

Perpheral Clock Rate: | Enable Timer

i &

ak. | Cancel I

Figure2.35 Simulator System Dialog Box

e Confirm that [Enable] in [System Call Address] is checked.
e Click the [OK] button to enable the Simulated I/O
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e Select [CPU->Simulated 1/Q] from the [View] menu and open the [Simulated |/O] window.
The Simulated I/O will not be enabled if the [Simulated 1/0] window is not open.

(71 thesmn - High-peslormance tmbedded Warkshog - [Demo] Jt
Sfe Edb Wew [rowet Bukd [ebug Sehp ek Wndow Qobons Meb SIOLE

DELD & S N e Y T T | e Siae
on B R ]
ABEDE | "= EWE FudumPrrc.« B E e 2 8 8a
=l
Y e [ &[]
S Arvendy e 41 | 00001086 =
B ose 44 | oo0O1OSE 5]
= £ Cs 45 | 0D0010%n
[Demcic] 47 | Q00010
g.,‘,_,:. 48 | oooo1oed
1B e 49 | 00001068
18 eseruge 50 | ooo0TOss
1] sk 51
15 veenti: 52 | ooOOLOBZ
= 23D e 53
1) Demosha e
= e e =
(5] kometsc:h 56
W sbikh :7 K:Mﬂlﬂh
18 = 58 | ooooiobe
ﬂ [I”ﬂ:h 58 | 00O01GC0
[ weeen 60 | DDOOIges o I
G ; 4][" nnAn A a(3]=0908 L .Lj‘;
= ST "% Dea

[T =T ok ) pebug £ Findin Fees | ersion Cortred |
Rmady IT OO 7] oefmki desliog _ Read-nikn A7 [£] i

Figure2.36 Simulated 1/O Window

245 Setting Trace Information Acquisition Conditions

e Select [Code->Trace] from the [View] menu and open the [ Trace] window. Open the pop-up menu by right clicking
the mouse on the [ Trace] window, and select [Acquisition...] from the popup menu.

The[Trace Acquisition] dialog box below will be displayed.
Trace Acquisition d

Cancel I

—Ih=truction Tvpe
* | [nstruction
" Subroutine

— Trace Buffer Full Handling
% Continue
" Break

— Trace Gapacity
1024 records
{4096 records
{16384 records
) 32768 records

Figure 2.37 Trace Acquisition Dialog Box

e Set [Trace start/Stop] to [Enable] in the [Trace Acquisition] dialog box, and click the [OK] button to enable the
acquisition of the trace information.
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2.4.6 Status Window
The termination cause can be displayed in the [ Status] window.

e Select [CPU->Status] from the [View] menu to open the [Status] window, and select the [Platform] sheet in the
[Status] window.

|
[zeem  [svatus
Connected To SH-1 Simulator
(k) EH-1
Exec Mode Stop
Durn Status Beady
Ereal Cause PC Breakpoint
Execute From Pipeline Beset
Exec Instructions 3ZZ9
Cyocles Ta7E
! | o
A k' Mernory p Platform £ Everts f

Figure2.38 View->CPU->Staus Window

24.7 RegistersWindow
Register values can be checked in the [Register] window.

e Sdect [CPU->Registers] from the [View] menu.

£
Mane Value Badix
ooono b

Rl aaoo Hex

B2 oaao Hex

B3 oaao Hex

a0 oaao Hex

Al oaao Hex

FE oaao Hex

TaP oaon Hex

ISP oaon Hex

P OFOooo Hex

SE aaoo Hex

INTE Qooooo Hex

1en| u| 7] o] 8] 5] 2 o] <] |
O oooo0oO0O0O0OoO0

Figure2.39 View ->CPU-> Register Window
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24.8 Trace
(1) TraceBuffer
The trace buffer can be used to clarify the history of instruction execution.

e Select [Code->Trace] from the [View] menu and open the [Trace] window. Scroll up to the very top of the window.

|
FTR | Cycle | Address | Pipeline | Instruction | Access Data | Source | Lahel |ﬂ
-... 000... 00001046 f£<D>E nov RE,... Rl4<-00000...
-... 0O0... 00001048 FFDE> nov R4,... R13<-00005...
-... 000... 00001044 £L-EMMU Mov.L @({0... RE<-00005BS0
-... 000... 0000104C FFD<<E... MOV.L @(0... RZ<-000015AC
-... 000.,.. 0000104E £<<D=E> nov R13... R4<-00005ES0
-... 0O00... 00001050 FFD:E T5R €] 384 PC«<£-000015AC
-... 000... 00001052 £>-D>E Hap
-... 000... O000015AC FFDE> nov R4,... RO<L-00005B50 S EET
-... 00O0... O000015%E £D-E )53 R5,... RO<L-00005ESO
-... 000... 000015E0 FFLE> TaT #03... T<-(1)
-... 00O0... 000015BZ £D-E EF ooo... T(l)
-... 000... 000015E4 FFDE-MMU Mov.L [@E5... R3<-73746469 . O LI

Figure2.40 Trace Window (Trace Information Display)
(2) Trace Search

Click the right mouse button on the [Trace] window to launch the pop-up menu, and select [Find...] to open the [Trace
Search] dialog box.

" Gychg Cancel |

 fddrezs
" Ihstruction

Walue:

Figure2.41 Trace Search Dialog Box

Setting the item to be searched to [Item] and the contents to be searched to [Value] and clicking the [OK] button begins
the trace search. When the searched item is found, the first line is highlighted. To continue searching the same contents
[Valug], click the right mouse button in the [ Trace] window to display the pop-up menu, and select [Find Next] from the
pop-up menu. The next searched line is highlighted.
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i E|
PTR | Cycle Address Pipeline Instruction IAccess Data I Source I Label I;I
-... 000... 00001054 FFDE> Hav RO,... RZ<-00000000 —
-... 000... 00001056 fD>E TST R2,... T<-=(1)
-... 000... 00001053 FFDE> EF ooo... TiL)
-... 000... 00001054 £D-E Hov R14... RO<-00000001
-... Q000... 0000l0SC FFDE> TST #01... T<-(0)
-... 000... OOQOLOSE f£D>E> EF ooo... T, PC<-...
-... 000... 00001060 FFDe-
-... 000... 000o0logz £
-... 000... 00001066  FFD-EMMW Mov.L [@(0... R2<-0OFFFELAC
-... 000... 00001065 FFD<<ExM HOV.E FRl4... OFFFELAC<-01
-... 000... 00001064 E£<<D:E Hov #00... PRz<-00000000
-... 000... 000010&6C  FFDE ER4 ooo... PC<-0000LOCE LI
Figure2.42 Trace Window
24.9 Displaying Breakpoints

A list of all the breakpoints that are set in the program can be checked in the [Eventpoint] window.

e Select [Code->Eventpoint] from the [View] menu.

L&
Tvpe State Condition
EF Enahle PC=H'OOO00AGZ (sample. c/27)
EF Enahle PC=H'O0000ASE (sample. o /29)
1 | i
A | &I, Software Break £ Scfware Evert f

Figure 2.43 Eventpoint Window

A breakpoint can be set, a new breakpoint can be defined, and a breakpoint can be deleted using the [Eventpoint] window.

e Close the [Eventpoint] window.

2.4.10

Displaying Memory Contents

The contents of memory block can be displayed on a Memory window. For example, the procedure for displaying the
memory for the main column in byte size is shown as below.

Select [CPU->Memory...] from the [View] menu to enter memory area start address in the [Begin] field and end address

in the [End] field.

RENESAS
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Click on the [OK] button to open the Memory window which shows the specified memory area.

Display Address

Dizplay Address:

Scroll Start Addrezs

Scroll End Address:

| 00000000

. |00000000

|FFFFFFFF

Cancel |

Figure2.44 Set Address Dialog Box

Memory [000000] |
’Tllllll::::ll__smimﬁZ”Eabﬁ&|.t.d.16m|@
address | Tsbel | Register | +0 +1 +2 +3 +4 +5 +6 +7 +8 +0 +a +B +C +D +E +F | AScCIT [«
0ooooog [FE][=2E][USP] OO 0O 0O 0O OO OO OO OO 00O 00O 00 00 00 00 00 00 ... .ewveevennsnss ]
000010 00 00 00 00 00 00 00 OO0 00 OO0 00 00 00 00 00 00 «uvvevienveeen..
oonozo oo o0 00O OO OO OO QO Qo0 00 00 00 00 00 00 00 00 ... .ieeeeeaean
000020 oo 00 00O OO 00O 0O 00 00 00 00 00 00 00 00 00 00 &.eeesenweannens
000040 00 00 00 00 00 00 00 OO0 00 OO0 00 00 00 00 00 00 «uvvevienveeen..
oonos0 oo o0 00O OO OO OO QO Qo0 00 00 00 00 00 00 00 00 ... .ieeeeeaean
0000e0 oo 00 00O OO 00O 0O 00 00 00 00 00 00 00 00 00 00 &.eeesenweannens
000070 00 00 00 00 00 00 00 OO0 00 OO0 00 00 00 00 00 00 «uvvevienveeen..
000080 00 00 00 00 00 00 00 OO0 00 OO0 00 00 00 00 00 00 «uvvevienveeen..
oooo2o oo 00 00O OO 00O 0O 00 00 00 00 00 00 00 00 00 00 &.eeesenweannens
0000A0 00 00 00 00 00 00 00 OO0 00 OO0 00 00 00 00 00 00 «uvvevienveeen..
0000B0D 00 00 00 00 00 00 00 OO0 00 OO0 00 00 00 00 00 00 «uvvevienveeen..
ooooco oo 00 00O OO 00O 0O 00 00 00 00 00 00 00 00 00 00 &.eeesenweannens
0000D0 00 00 00 00 00 00 00 OO0 00 OO0 00 00 00 00 00 00 «uvvevienveeen..
O000ED 00 00 00 00 00 00 00 OO0 00 OO0 00 00 00 00 00 00 «uvvevienveeen..
0000FO oo oo 00O OO OO OO OO0 o0 00 00 00 00 00 00 00 00 &.eeesenwsanneas
000100 00 00 00 00 00 00 00 OO0 00 OO0 00 00 00 00 00 00 «uvvevienveeen..
000110 00 00 00 00 00 00 00 OO0 00 OO0 00 00 00 00 00 00 «uvvevienveeen..
0oo1zo oo oo 00O OO OO OO OO0 o0 00 00 00 00 00 00 00 00 &.eeesenwsanneas
000130 00 00 00 00 00 00 00 OO0 00 OO0 00 00 00 00 00 00 «uvvevienveeen.. =
|

Figure 2.45 Memory Window
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25 Standard 1/0 and File /O Processing in the Simulator/Debugger

The simulator/debugger allows the user to perform the standard 1/0 and file I/O from the programe to be debugged. When
the /0O processing is executed, the Simulation 1/0 window must be open. The supported 1/O processing is as follows:

Table 2.3 1/0 Functions

No. Function Function Description
Code name
1 H'21 GETC Inputs one byte from the standard input device.
2 H'22 PUTC Outputs one byte to the standard output device.
3 H'23 GETS Inputs one line from the standard input device.
4 H'24 PUTS Outputs one line to the standard output device.
5 H'25 FOPEN Opens a file.
6 H'06 FCLOSE Closes a file.
7 H'27 FGETC Inputs one byte from a file.
8 H'28 FPUTC Outputs one byte to a file.
9 H'29 FGETS Inputs one line from a file.
10 H'2A FPUTS Outputs one line to a file.
11 H'0B FEOF Checks for end of file.
12 H'0C FSEEK Moves the file pointer
13 H'0D FTELL Returns the current position of the file pointer.

To perform 1/O processing, first specify the location for 1/O in the [System Call Address] in the Simulator System dialog
box, check the [Enable], and then execute the program to be debugged.

When detecting a subroutine call instruction (BSR, JSR, or BSRF), that is, a system call to the specialized address during
user program execution, the simulator/debugger performs 1/0 processing by using the RO and R1 values as the parameters.

Therefore, beforeissuing a system call, set as follows in the user program:

e Set the function code (table 2.3) to the RO register

MSB 1 byte 1 byte LSB
H'01 Function
Code
e Set the parameter block address to the R1 register
(For the parameter block, refer to each function description)
MSB LSB

Parameter block address ‘

e Reservethe parameter block and I/O buffer areas

In case of accessing each parameter of the parameter block, after the I/O processing in the parameter size, the
simulator/debugger resumes simulation from the instruction that follows the system call instruction.
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Note: If the JSR, BSR, or BSRF instruction is executed as system call, an instruction following the JSR, BSR, or BSRF
isas an ordinary instruction, not a slot instruction. Hence, any instruction whose result will differ depending on the
slot instruction or ordinary instruction should not be used following the JSR, BSR, or BSRF.

1) ) (4)
©)

Parameter Block (5)
Parameters  (6)

Figure 2.46 Description Format of the I/O Function
The contents of the items are as follows:
(1) Number corresponding to table 2.3
(2) Function name
(3) Function Code
(4) 1/0 overview
(5) 1/0O parameter block

(6) 1/0 parameters

1 GETC Inputs one byte from the
H21 standard input device
Parameter Block One byte One byte
+0
2 Input buffer start address
Parameter e Input buffer start address (input)

Start address of the buffer to which the input data is written to

2 PUTC Outputs one byte to the
H'22 standard output device.
Parameter Block One byte One byte
+0

) Output buffer start address
+
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Parameter ¢ Output buffer start address (input)

Start address of the buffer in which the output data is stored

3 GETS Inputs one line from the
H'23 standard input device.
Parameter Block One byte One byte
+0
Input buffer start address
+2
Parameter e Input buffer start address (input)

Start address of the buffer to which the input data is written to

4 PUTS Outputs one line to the
H'24 standard output device.
Parameter Block One byte One byte
+0
) Output buffer start address
+
Parameter ¢ Output buffer start address (input)

Start address of the buffer in which the output data is stored

5 FOPEN
H'25

Opens a file.

The FOPEN opens afile and returns the file number. After this processing, the returned file number must be used to input,
output, or close files. A maximum of 256 files can be open at the same time.

Parameter Block One byte One byte
+0 | Return Value File number
+2 | Open mode Unused
+4
6 Start address of file name
Parameter ¢ Return value (output)
0: Normal completion

-1: Error
e File number (output)
The number to be used in all file accesses after opening
Open mode (input)
H'00 "r"
H'01 "w"
H'02 "a"
H'03 "r+"
H'04 "w+"
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H'05 "at+"
H'10 "rb"
H'11 "wb"
H'12 "ab"
H'13 "r+b"
H'14 "w+b"
H'15 "a+b"
These modes are interpreted as follows:
"r": Open for reading.
"w": Open an empty file for writing
"a": Open for appending (write starting at the end of the file).
"r+": Open for reading and writing.
"w+": Open an empty file for reading and writing.
"a+": Open for reading and appending.
"b": Open in binary mode.
e Start address of file name (input)
The start address of the area for storing the file name

6 FCLOSE .
Closes a file.
H'06
Parameter Block One byte One byte
+0 | Return Value File number
Parameter ¢ Return value (output)

0: Normal completion
-1: Error
e File number (input)
The number returned when the file was opened

FGETC )
7 Inputs one byte from a file
H'27
Parameter Block One byte One byte
+0 | Return Value File number
+2 Unused

+4 Start address of input buffer
+6

Parameter ¢ Return value (output)
0: Normal completion
-1: Error
e File number (input)
The number returned when the file was opened
e Start address of input buffer (input)
The start address of the buffer for storing input data

8 FPUTC Outputs one byte to a file
H'28
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Parameter Block One byte One byte

+0 Return Value File number

+2 Unused

+4 Start address of output buffer
+6

Parameter ¢ Return value (output)
0: Normal completion
-1: Error
¢ File number (input)
The number returned when the file was opened
¢ Start address of output buffer (input)
The start address of the buffer used for storing the output data

9 FGETS Reads character string data from a file
H'29
Parameter Block One byte One byte
+0 | Return Value File number
+2 Buffer size

+4 Start address of input buffer
+6

Parameter ¢ Return value (output)

0: Normal completion
-1: EOF detected

e File number (input)
The number returned when the file was opened

e Buffer size (input)
The size of the area for storing the read data
(A maximum of 256 bytes can be stored)

¢ Start address of input buffer (input)
The start address of the buffer for storing input data

10 FPUTS Writes character string data to a file
H'2A
Parameter Block One byte One byte
+0 | Return Value File number
+2 Unused

+4 Start address of output buffer
+6

Parameter ¢ Return value (output)
0: Normal completion
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-1: Error
e File number (input)
The number returned when the file was opened
¢ Start address of output buffer (input)
The start address of the buffer used for storing the output data

Parameter Block

Parameter

11 FEOF Checks for end of file
H'0B
One byte One byte
+0 Return Value File number

¢ Return value (output)
0: File pointer is not at EOF
-1: EOF detected
e File number (input)
The number returned when the file was opened

12 FSEEK Moves the file pointer to the specified
HoC position
Parameter Block One byte One byte
+0 | Return Value File number
+2 Direction Unused
+4 Offset
+6
Parameter ¢ Return value (output)
0: Normal completion
-1: Error
e File number (input)
The number returned when the file was opened
¢ Direction (input)
0: The offset specifies the position as a byte count from the start of the file
1: The offset specifies the position as a byte count from the current file pointer
2: The offset specifies the position as a byte count from the end of the file
¢ Offset (input)
The byte count from the location specified by the direction parameter
13 FTELL Returns the current position of the
H'OD file pointer.
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Parameter Block One byte One byte
+0 | Return Value File number
+2 Unused
+4 Offset
+6
Parameter e Return value (output)

0: Normal completion
-1: Error

¢ File number (input)

The number returned when the file was opened

¢ Offset (output)
The current position of the file pointer
(A byte count from the start of the file)

The following shows an example for inputting and outputting one character as a standard input (from a keyboard).

; FILE :lowlvl.src
: DATE :Tue, Mar 05, 2002
; DESCRIPTION :Program of Low level

7 CPU TYPE

; This file is generated by Renesas Project Generator (Ver.3.0).

; SH-series simulator debugger interface routine

i -Input/output one character-

.EXPORT _charput
.EXPORT _charget

SIM_IO: .EQU H'0000 ;Specifies TRAP_ADDRESS
.SECTION P, CODE, ALIGN=4

;  _charput: One character output

; C program interface: charput (char)

_charput:

RENESAS
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MOV.L O_PAR, RO ; Sets output buffer address to RO
MOV.B R4, @RO ; Sets output charcter to buffer
MOV.L #0O_PAR,R1 ; Sets parameter block address to R1
MOV.L #H'01220000,R0 ; Specifies function code (PUTC)
MOV .W #SIM_TIO,R2 ; Sets system call address to R2
JSR @R2

NOP

RTS

NOP
.ALIGN 4

O_PAR: ; Parameter block

.DATA.L OUT_BUF

; _charget: One character input

; C program interface: char charget (void)

.ALIGN 4
_charget:
MOV.L #I_PAR,R1 ; Sets parameter block address to R1
MOV.L #H'01210000,R0 ; Specifies function code (GETC)
MOV .W #SIM_TIO,R2 ; Sets system call address to R2
JSR @R2
NOP
MOV.L I_PAR,RO ; Sets input buffer address to RO
MOV.B @RO, RO ; Returns input data
RTS
NOP
.ALIGN 4
I_PAR: ; Parameter block
.DATA.L IN_BUF
: I/0 buffer definition
.SECTION B,DATA,ALIGN=4
OUT_BUF':
.RES.L 1 ; Output buffer
IN_BUF:
.RES.L 1 ; Input buffer
. END
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31 Interrupt Functions

311 Definitions of Interrupt Functions (No Options)
Description:

Preprocessor directive (#pragma) can be used to create interrupt functions in the C language. A function declared using
"#pragmainterrupt” saves/restores all registers (except for the global base register GBR and vector base register VBR) to
be used within the function before and after function processing. For this reason, interrupted functions do not need to make
provisions to deal with interrupts.

e Format:
#pragma interrupt (<function name>,[<function name>...])

Example of use:

The interrupt function handlerl is declared. This function takes over the stack from the interrupted function and usesit,
and after the completion of processing, returns with an RTE instruction.

<Case where GBR, VBR are not saved/restored>

C language code

#pragma interrupt (handlerl) /* Declaresinterrupt function * /
void handlerl (void)
{
/* Interrupt function processing* /

}
Expanded into assembly language code

.EXPORT _handlerl
.SECTION P,CODE,ALIGN=4
_handlerl: ; function: handlerl
; Saveswork registers
; Interrupt function processing
; Restores work registers
RTE
NOP
.END

<When storing or restoring the GBR and VBR>
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C language code

#pragma interrupt (handlerl)
void handlerl (void)

{

void** save_vbr; /* Definesthe VBR storagearea * /
void* save_gbr; /* Definesthe GBR storage area  * /
save_vbr = get_vbr(); /* SavesVBR */
save_gbr = get_gbr(); /* Saves GBR */

/* Interrupt function processing  */

set_vbr (save_vbr) ; /* Restores VBR */
set_gbr (save_gbr) ; /* Restores GBR */
}
Expanded into assembly language code

.EXPORT handlerl
.SECTION P,CODE, ALIGN=4
handlerl: ; function: handlerl
; frame size=8
MOV.L R5,@-R15
STC GBR, R5 ; Saves GBR
MOV.L R4,@-R15
STC VBR, R4 ; Saves VBR
; Saves work registers
; Interrupt function processing
; Restores work registers
LDC R4 ,VBR ; Restores VBR
LDC R5, GBR ; Restores GBR
MOV.L @R15+,R4
MOV.L @R15+,R4
RTE
NOP
.END

Important Information:

(1) Only the void data type can be returned by an interrupt function.

Examples:
#pragma interrupt (fl, f£2) /* Declaresinterrupt function */
void fl(void){...} /* Definesinterrupt functionfl  */
int £2 (void) {...} /* Definesinterrupt functionf2 ~ */

The definition of the interrupt function f1 is correct, but the definition of the interrupt function f2 resultsin an error.
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(2) The only memory class specifier that can be specified in the definition of an interrupt function is extern. Even if static
is specified, it istreated as extern.

(3) function declared as an interrupt function cannot be called as an ordinary function. If afunction declared as an
interrupt function is called as an ordinary function, runtime operation is not guaranteed.

Examples:

o test1.c file contents
#pragma interrupt (f1) /* Declaresinterrupt function */
void f1(void){...} /* Declaresinterrupt function f1 */

int £20){f10);}

o test?.c file contents
£30)( f10); )}

In the file testl.c, an error occurs at function f2. In the file test2.c, an error does not occur at the function 3, but the
function f1 isinterpreted as extern int f1(), and runtime operation becomes unstable.

(4) In the event of an interrupt, the operation of SH-3, SH3-DSP, SH-4A and SH4AL-DSP differs from that of SH-1, SH-2
SH-2E, SH-2A, SH2A-FPU and SH2-DSP, and an interrupt handler is necessary. An example of an interrupt handler is
shown below.

Example of an Interrupt Handler for SH-3

PR R R I I I I I R R R R I I R I R I I R S I I I R R I S
7

; FILE :vhandler.src

PR R R R I I I S I I I I R R R I I S R R I I S I I I R S
7

.include "env.inc"

.include "vect.inc"

IMASKclr: .equ H'FFFFFFOF

RBBLclr: .equ H'CFFFFFFF

MDRBBLset : .equ H'70000000
.import _RESET_Vectors
.import _INT_Vectors
.import _INT MASK

PR R R I I I I S I I I I I R R I R R R I I I R R I I S I R R R R I
7

:* macro definition

PR R I I I I S I I I I R R R I I S R R I I R I I R R R I
7

.macro PUSH_EXP_BASE_REG

stc.1l ssr,@-rl5 ; save ssr

stc.1l spc, @-rl5 ; save spe

sts.1l pr,@-rl15 ; save context registers
stc.1l r7_bank,@-rl5

stc.1l r6_bank,@-rl5

stc.1l r5_bank,@-rl5
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stc.1l r4_bank,@-rl5

stc.1l r3_bank,@-rl5

stc.1l r2_bank,@-rl5
1 rl _bank,@-rl5
1

r0_bank,@-r15

stc.
stc.

.endm

.macro POP_EXP_BASE_REG

ldec.1 @rl5+,r0_bank ; recover registers
ldc.1 @rl5+,rl_bank
ldc.1 @rl5+,r2_bank
ldc.1 @rl15+,r3_bank
ldc.1 @rl5+,rd4_bank
ldc.1 @rl15+,r5 bank
ldc.1 @rl5+,r6_bank
ldc.1 @rl5+,r7_bank
lds.1 @rl5+,pr
ldc.1 @rl5+, spc
ldc.1 @rl5+,ssr

.endm

PR I I S I S R R I R S I R S I S R R I I S S S R R I S R R S S I I S
7

; reset
I.*******************************************************************
.section RSTHandler, code

_ResetHandler:

mov.l #EXPEVT,r0

mov.l @r0,r0

shlr2 r0

shlr r0

mov.l #_RESET_Vectors,rl

add rl,r0

mov.l @r0,r0

Jjmp @ro

nop

PR I R I S S R R I R S I S R I I R R R I I I S I I I I I R I S I I
7

; exceptional interrupt
I.*******************************************************************
.section INTHandler, code

.export INTHandlerPRG

Rev.4.00 2007.02.02 3-4
REJ05B0463-0400
RENESAS



Section 3 Compiler

INTHandlerPRG:

_ExpHandler:

7

PUSH_EXP_BASE_REG

mov.l #EXPEVT,r0

mov.l @r0,rl

mov.l #_INT_Vectors,r0
add #-(h'40),rl
shlr2 rl

shlr rl

mov.l @(r0O,rl),r3

; set event address

; set exception code

; set vector table address
; exception code - h'40

; set interrupt function addr

mov.l #_INT MASK,r0 ; interrupt mask table addr
shlr2 rl

mov.b @(r0,rl),rl ; interrupt mask
extu.brl,rl

stc sr,r0 ; savesr

mov.l #(RBBLclr&IMASKclr),r2 ; RB,BL,mask clear data
and r2,r0 ; clear mask data

or rl,r0 ; set interrupt mask

ldc r0, ssr ; Set current status

ldc.1l r3,spc
mov.l #__int_term,r0

1ds r0,pr

rte

nop

.pool

; setinterrupt terminate

PR I R I I S R R I I R S I R I I R S R R I I S S S R I I I I S I S I I
I

: Interrupt terminate

PR I I I S R R I S I R I 